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Section 1—Introduction
The NuFlo™ MC-III™ EXP Flow Analyzer (Figure 1.1) packs a full spectrum of gas and liquid measurement 
functionality, high-speed performance, and log archive and retrieval capabilities in an easy-to-use, explosion-
proof totalizer. Commonly used operations can be accessed from the six-button keypad on the front of the 
instrument or from the dynamic interface software, allowing you to calibrate and configure the unit quickly 
and easily.   

Operation
The MC-III EXP calculates and displays 
instantaneous flow rates and accumulated totals 
based on a turbine flowmeter input signal. The 
MC-III’s microprocessor circuitry counts the 
pulses generated by a companion flowmeter, 
converts that data into volume and rate values 
in accordance with calibration settings, and 
displays the totalized data on a two-line liquid 
crystal display (LCD). The eight-digit top readout 
indicates total flow volume; the six-digit bottom 
readout indicates flow rate.

With the press of a single key, totals are saved to 
nonvolatile memory, minimizing the risk of data 
loss even if a power outage occurs.

Up to 384 daily logs, 768 hourly logs, and 345 
event logs can be archived and accessed quickly 
on demand.

Offering a variety of user-configurable display 
options, input and output options, RS-485 
Modbus® compatibility,  flow logging, and turbine 
flowmeter linearization, the MC-III EXP is one 
of the most versatile totalizers on the market. For 
specifications, see Table 1.1, page 2.

An optional explosion-proof reset switch further 
expands the unit’s versatility, making it possible 
to reset the total and view daily flow logs without 
opening the enclosure.

Figure 1.1—MC-III EXP flow analyzer
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Table 1.1—MC-III EXP Specifications
Enclosure CSA-approved for US and Canada

Class I, Div. 1, Groups B, C, D (explosion-proof)
Type 4 enclosure
T6 temperature class

System Power Internal power supply
3.6 VDC, D-size lithium battery (2-year typical life) 
alkaline battery pack containing 3 C-size industrial-grade batteries

External power supply (6 to 30 VDC) with internal battery backup (reverse 
polarity protected)

Loop-powered (4-20 mA) with internal battery backup
(reverse polarity protected)
Loop power: 8 to 30 VDC
Load resistance:  1100 ohms @ 30 VDC; 200 ohms @ 12 VDC

•
•

Operating Temperature Lithium-Powered: -40°C  to 70°C (-40°F to 158°F)
Alkaline-Powered: -18°C  to 55°C (0°F to 130°F) 
LCD contrast is reduced below -20°C (-4°F)

LCD Display 8-digit Total (volume) display (7-segment characters)
6-digit Rate display (11-segment characters for easy-to-read prompts)
0.3” character height
Adjustable contrast and update period
User-selectable units of measurement (Total):

Preprogrammed units: BBL, GAL, LIT, M3, CF, SCF, any unit x 1000
User-defined units 

User-selectable units of measurement (Rate):
Preprogrammed units: BBL, GAL, LIT, M3, CF, SCF (per DAY, HR, 
MIN, SEC), any unit x 1000 (per DAY, HR, MIN, SEC)
User-defined units

•
•

•

•
Keypad 6-key membrane switch
Communications/ 
Archive Retrieval

RS-485 Modbus® communications with transfer speeds up to 115.2K (allows 
full download in less than 1 minute)

Logging 384 daily logs
768 hourly logs
345 event logs

Inputs Turbine Meter Input 
Configurable sensitivity adjustment via front panel
Sensitivity adjustment range:  20 mV P-P to 40 mV P-P 
Frequency range:  0 to 3500 Hz 

Remote Reset Input 
Optically-isolated input 
3.0 to 30 VDC 
Pulse duration > 3 seconds to reset

Explosion-Proof Reset Switch (option) 
Press and hold > 3 seconds, then release to reset total
Press and hold < 1 second, then release to view daily log data
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Table 1.1—MC-III EXP Specifications
Inputs (cont’d) Pulse Input

Optically-isolated input 
3.0 to 30 VDC

Outputs Analog Output 
4-20 mA, loop-powered (two-wire) 
16-bit resolution 
Accuracy:  0.1% of full scale @ 25°C, 50 PPM/°C temperature drift 
Loop power:  8.0 to 30 VDC 
Zero and full-scale engineering values configurable from front panel

RS-485 Communications 
Baud rates: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 57600 and up 
to 115.2K

Volumetric Pulse Output 
Solid-state relay
Output rating: 60 mA max. @ 50 VDC, on-state drop = 1.4 VDC @ 50 mA, 
0.25 VDC @ 10 mA
Configurable pulse width (duration): 10 to 60,000 ms

Amp & Square (Flowmeter Frequency) Output 
Open-drain transistor output of turbine meter input signal 
Output rating: 50 mA @ 30 VDC, on-state drop = 0.3 VDC @ 50 mA,  
0.1 VDC @ 10 mA
(Analog output and amp & square outputs cannot be used simultaneously.)

Modbus® RTU mode Modbus® supports 16-bit and 32-bit holding registers. For more 
information, see Appendix D.

Enron Modbus® Flow log parameters (time stamp, period total, period run time, and supply 
voltage) and download method are Enron-compatible.

System Requirements Operating System - Windows 2000 or later (Windows XP recommended)
Computer/Processor - 1 GHz or faster Pentium-compatible CPU
Memory - 128 MB of RAM
Hard Disk Space - 21 MB for program files, 30 MB for Adobe Reader, 
adequate space for data files
Drive - CD-ROM for install
Display - 800 x 600 (SVGA), 16-bit (thousands of colors) color display or 
greater
Browser - Internet Explorer 4 or later
Internet Connection - for web links, tech support
Communications Port - physical or virtual RS-232 compatible serial port

Key Product Features 
This section presents an overview of key features of the MC-III EXP. Many of these features are discussed in 
more detail in Sections 3 and 4 (configuration procedures) and Section 5 (flow log archival). 

Key features discussed here include:

LCD display
keypad
interface software

•
•
•
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power supply
calibration options
input options
output options
flow log archival
password-protected security
explosion-proof reset switch (option)
RS-485 IS barrier (option)

LCD Display
The liquid crystal display (Figure 1.2, page 5) provides a simultaneous indication of accumulated total (top 
readout) and flow rate (bottom readout). The eight-digit total display uses 7-segment characters to form 
numbers and letters, which results in a combination of uppercase and lowercase letters. The six-digit flow rate 
display uses 11-segment characters to form numbers and letters for improved readability. When the keypad 
is used to calibrate the MC-III EXP, the name of the menu option selected appears in the lower (rate) display, 
and settings are entered in the top (total) display.

Flow volume can be measured in barrels, gallons, liters, cubic meters, cubic feet, standard cubic feet or other 
user-defined units. A multiplication factor is also available for indicating flow volume in terms of 1,000 units. 
The unit of measure for the Total readout and the decimal point position are selected by the operator during 
calibration. If a user-defined unit is used, none of the preprogrammed volume units will be visible on the 
display during operation. 

Flow rate can be measured in a wide variety of preprogrammed units, or other user-defined units. The flow 
rate unit of measure is selected in two steps: (1) a volume unit is chosen and (2) a time-base unit (per day, per 
hour, per minute, or per second) is chosen. Users can choose any combination of preprogrammed volume and 
time units in establishing the flow rate engineering unit (for example, gallons per hour, gallons per day, or 
gallons per minute). Also, the volume unit used for the flow rate can be different from the volume unit used to 
read Total volume. The unit of measure for the Rate readout and the decimal point position are selected by the 
operator during calibration.

The daily index (Day) display is a two-digit number for selecting a daily archive log for viewing. The number 
shown here represents the number of days that have passed since the log was saved. For example, an entry of 
01 would yield yesterday’s log. An entry of 05 would yield the log generated 5 days ago. Up to 99 consecutive 
daily logs can be viewed using the keypad. In addition, up to 384 daily logs, 768 hourly logs, and 345 event 
logs can be viewed through the interface software.

The LCD contrast can be adjusted with the interface software (see Section 4).

Keypad
The six-button keypad allows users to perform a basic configuration of the instrument. Figure 1.3, page 
5, summarizes the functions that can be accessed with each button. Most parameters can be configured in 
seconds by selecting one of the three menu keys (K-Factor, Output, or Display), navigating settings with the 
arrow buttons, and saving the selections with the Enter key.

Section 3 contains procedures for configuring the MC-III EXP using the keypad. Icons of the six buttons 
provide a pictorial reference to help guide users through each step of configuration.

•
•
•
•
•
•
•
•
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Important:  Some configuration parameters are accessible only through the interface software. See 
Section 4 for instructions on configuring the instrument using the software. 

00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD00Day

Total

Rate

Figure 1.2—LCD display showing location of the Total, Rate, and daily index (Day) displays. Only the units of 
measurement selected for displaying total and rate will be visible during normal operation.

Calibrate instrument
Set flowmeter input sensitivity
Select pulse input

Enable/disable/set up 4-20 mA output
pulse output

Enter slave address
Enter baud rate

Enable/disable/set up 

Set engineering units for Total readout
Set engineering units for Rate readout
Set decimal placement for both readouts

During calibration, navigates 
between submenus and scrolls 
through menu selections
During operation, accesses
daily volume archive During calibration, incrementally 

changes digits and decimal point 
position, on/off settings
During operation, tests temperature
and system voltage

During calibration, saves 
calibration settings
During operation, saves 
Total to nonvolatile memory
Note: To zero the Total 
readout, press the LOG (left 
arrow) and SAVE (ENTER) 
keys simultaneously.

Figure 1.3—MC-III EXP keypad functions
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Interface Software
Developed within the familiar Windows environment, the MC-III interface software is an intuitive and 
easy-to-use application that provides access to all controls for setting up and operating the instrument. The 
interface tailors the controls to the user’s needs, providing three options for configuring the instrument:

a “Configuration Wizard,” which steps through the most common configuration tasks
individual configuration menus for accessing specific settings
an advanced menu that gives host programmers access to Modbus® registers

For instructions on installing the interface software and entering configuration parameters via the interface 
software, see Section 4.

Power Supply
The MC-III EXP is shipped with either a lithium battery or an alkaline battery pack. Alternately, the MC-III 
EXP may be powered by an external power source; in this case, the lithium battery or alkaline battery pack 
provides a backup power supply, significantly extending battery service life. Low-power microprocessor 
technology enables the MC-III EXP to operate approximately 2 years on a single lithium battery. 

Wiring diagrams for connecting an external power supply are provided in Section 2.

Multipoint Linearization
The MC-III interface software supports up to 12 calibration points in addition to single-point calibration based 
on the K-factor provided with the turbine flowmeter. See K-Factor Type, page 56, for more information.

Gas Volume Correction
Gas turbine meters are calibrated in actual cubic feet (ACF), and measure gas in actual cubic feet. In some 
applications, a user may benefit from referencing gas measurements back to standard conditions by measuring 
in terms of standard cubic feet (SCF). The MC-III EXP makes this process quick and easy, by using fixed 
average values for the flowing gas temperature and flowing gas pressure. See Gas Volume Correction, page 
58, for more information.

Input Options
The flowmeter signal can be obtained from a magnetic pickup or a pre-amplifier device. The sensitivity of 
the flowmeter input may be adjusted with the instrument keypad or the interface software. See Section 2 for  
wiring diagrams. See Sections 3 and 4 for configuration procedures.

Output Options
The MC-III EXP standard circuitry provides:

a scaled pulse output representing an increment in volume for each pulse 
a loop-powered 4-20 mA output representing the flow rate
a flowmeter frequency output for use with remote equipment to derive flow rate and volume
an RS-485 output for communication with interface software or other telemetry equipment

When the 4-20 mA rate output feature is used, the MC-III EXP is powered by the current loop, and the lithium 
battery or alkaline battery pack is used as a backup supply. 

The pulse output and 4-20 mA output features should be turned off when not required for reduced current 
consumption. See Section 2 for wiring diagrams. See Sections 3 and 4 for configuration procedures.

•
•
•

•
•
•
•
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Flow Log Archival 
The MC-III EXP saves up to 384 daily logs and 768 hourly logs in nonvolatile memory. By connecting with 
the interface software, users can download the logs for viewing and/or printing in tabular format or in a trend 
chart. 

Users can also export daily and hourly logs to a spreadsheet. For more information, see Section 5.

Event Log Archival 
The MC-III EXP saves up to 345 user event logs. Event logs are generated to track user changes such as K-
Factor changes, input setting changes, power-on reset and “watch-dog” reset, flow cut-off and frequency cut-
off. 

By connecting with the interface software, users can download the logs for viewing and/or printing in tabular 
format. In addition to showing old and new values, each event log is time-stamped, and includes the register 
associated with the change. For more information, see Section 5.

Password-Protected Security
A keypad security access code prevents unauthorized personnel from altering the calibration or accumulated 
volume data in the instrument. The security feature may be disabled if this protection is not required.

Password-protected security access is enabled using the interface software. When this feature is enabled, 
the user will be prompted for a password when attempting to enter any menu from the keypad. For more 
information, see Security Setup, page 51.

Optional Features
Explosion-Proof Reset/Control Switch
An optional external reset/control switch can be mounted in either of the conduit openings near the top of 
the MC-III EXP enclosure, allowing the user to zero the total and view daily logs instantaneously without 
opening the enclosure or accessing the interface software. When the switch assembly is ordered with an MC-
III EXP, it is factory installed. When ordered separately, the switch assembly is easily installed using the 
instructions provided in this manual. For installation and wiring instructions, see Appendix A.

Zeroing the Total. To reset the total with an explosion-proof switch, press and hold the switch for 3 seconds, 
then release it.

Important:  When resetting the total with the explosion-proof reset switch, do not release the switch 
prematurely. Releasing the switch too quickly (before 3 seconds have passed) will  
activate the daily log view function and WILL NOT reset the volume to zero.

Viewing Daily Logs. To view daily logs with the explosion-proof switch, press the switch for 1 second 
and release it. Subsequent press-and-release actions increment the daily index, allowing the user to select 
a specific daily total. Additionally, when the log viewing function times out, the accumulated total is 
automatically saved to memory.

Saving the Total. When the daily log display times out, the MC-III EXP will automatically save the 
accumulated total.

Explosion-Proof Communications Adapter
An explosion-proof communications adapter provides an RS-485 connection for connecting a laptop or PC 
to the instrument without removing the instrument cover. When the adapter is ordered with an MC-III EXP, 
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it is factory installed. It may be relocated to either conduit opening in the instrument housing. When ordered 
separately, the adapter is easily installed using the instructions provided in this manual. For installation and 
wiring instructions, see Appendix A.

RS-485 IS Barrier
The MC-III EXP’s RS-485 output is approved for intrinsically safe installations. An intrinsically safe barrier 
assembly with a conduit seal enables the RS-485 output to be used as an intrinsically safe output. In such 
installations, only the turbine flowmeter input may be used. See Figure 2.15 (page 21) for an IS barrier 
assembly wiring diagram.

Commonly Used Functions
While the functions of the MC-III EXP are too numerous to mention, some of the most commonly used 
functions are detailed in this section. They include:

reading the rate and accumulated total
saving totals to memory
resetting the total
viewing daily and hourly logs
saving and uploading configuration files
exporting log data to spreadsheet
saving log data in a report

Reading Totals
Current totals can be viewed from the LCD on the front of the MC-III EXP or from the interface software 
(MC-III Main screen). The software calculates the flow total and updates the LCD display every 4 seconds, by 
default. The user can adjust the calculation period with the interface software. See Calculation Period, page 
55, for more information.

Saving Totals to Memory
Hourly and daily totals are automatically saved to nonvolatile memory. A user may also save an accumulated 
total at any time by opening the enclosure and pressing ENTER (SAVE) on the keypad. In the event of a 
power failure, the last saved total will be displayed on the LCD when power is restored. See also Explosion-
Proof Reset/Control Switch, page 7.

Note: Always save the accumulated total before replacing batteries. 

Resetting the Total
Totals can be reset to zero using the keypad, the interface software, an explosion-proof switch mounted in the 
top of the enclosure (if equipped), or a pulse from an external device.

To reset the total with the keypad, press LEFT ARROW (LOG) and ENTER (SAVE) keys simultaneously. 
To reset the total with the interface software, double-click the NuFlo MC-III icon on the computer desk-
top and wait for the software to connect to the instrument; then select MC-III Main from the Device 
Autorun Options screen, and click on the “Reset Flow Total” button in the lower right corner of the Main 
screen.

•
•
•
•
•
•
•

•
•
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To reset the total with an explosion-proof switch, press and hold the switch for 3 seconds, then release it. 
See also Explosion-Proof Reset/Control Switch, page 7.
To reset the total with an external pulse generator located in safe area, configure the pulse to be active for 
3 seconds. See also Remote Reset Input, page 16.

Viewing Daily and Hourly Logs
Each day, as the user-defined contract hour passes, a daily flow total is saved to nonvolatile memory. Hourly 
logs are also automatically saved. A total of 384 daily logs and 768 hourly logs are accessible for viewing and 
exporting using the interface software. See Section 5 for details.

Up to 99 daily flow log totals can be viewed from the LCD. Hourly flow log totals are accessible only through 
the interface software.

To view daily flow totals from the LCD, perform the following steps:

 Press the LEFT ARROW (LOG) key on the keypad. The words “Daily Volume Archive” will scroll across 
the bottom of the LCD and the day index will display “01.” The daily flow total recorded at the last con-
tract hour will appear at the top of the LCD. 
 
The index number represents the number of days previous to the current date. For example, yesterday’s 
totals are read by entering an index of “01”; totals from two days previous are read by entering “02.”

 Press UP ARROW (TEST) to increment the index (01, 02, 03...); press LEFT ARROW (LOG) to decre-
ment the index (01, 99, 98...).

 Press Enter (Save) to exit the Daily Volume Archive menu. (After 2 minutes of inactivity, the Daily Vol-
ume Archive menu will timeout and the total readout will be restored automatically.) 

The optional explosion-proof reset switch also allows users to view daily log totals. For more information, see 
Explosion-Proof Reset/Control Switch, page 7.

Saving and Uploading Configuration Files
The MC-III interface software allows users to save an unlimited number of configuration files to their 
computer. In the event that a configuration setting gets changed unintentionally or a user simply wants to 
restore the settings he used previously, the user can upload the configuration file and resume operation within 
minutes. The upload function also allows a configuration file to be loaded quickly into multiple devices. The 
default directory for saving configuration files is C:\NuFlo log data\MC-III. However, the user can specify a 
different location, if desired.

For complete information, see Saving and Uploading Configuration Files, page 66.

Exporting Log Data
Flow logs and event logs can be directly exported to an .xls or .csv file. For complete information, see 
Exporting Flow Logs, page 79, and Exporting Event Logs, page 82. The default directory for exported logs is 
C:\NuFlo log data\MC-III. However, the user can specify a different location, if desired.

Saving Log Data in a Report
Flow logs can be saved in a report format that can be loaded back into the software for viewing or printing at 
a later time. For complete information, see Printing/Saving a Report, page 75. The default directory for log 
reports is C:\NuFlo log data\MC-III\<WELL NAME>. However, the user can specify a different location.

•

•

1.

2.

3.
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Section 2—Installation
The MC-III™ EXP is fully assembled at the time of 
shipment and ready for mounting to a flowmeter. The  
MC-III EXP is shipped with ¾” recessed pipe plugs 
installed facing right and left, and the pipe union facing 
downward (Figure 2.1). If the device is equipped with an 
explosion-proof reset switch, only one plug is required. The 
switch may be installed in the right or left conduit opening.

Warning:  To prevent ignition of hazardous  
atmospheres, do not remove the cover 
while circuits are alive. Under normal  
conditions, the MC-III EXP poses no  
hazard when opened in a safe area.   

Preparation
Before attempting to install the MC-III EXP, make sure the 
flowmeter and magnetic pickup are installed as follows:

 Install the turbine flowmeter in the flow line.

 Lightly grease the threads on both ends of the magnetic 
pickup, taking care to keep grease off of the connector 
contacts. If the connector is plastic, apply grease only to 
the end that threads into the meter.

 Install the magnetic pickup in the flowmeter. 

 After the flowmeter and magnetic pickup are installed 
in the flow line, mount the MC-III EXP flow analyzer 
as described below.

Connection to the Flowmeter
To install the MC-III EXP on a turbine flowmeter, perform 
the following steps:

 Position the MC-III EXP above the flowmeter.

 Plug the MC-III EXP cable connector into the magnetic 
pickup and hand-tighten the knurled nut on the connec-
tor.

 Screw the MC-III EXP onto the flowmeter threads sur-
rounding the magnetic pickup with the display facing 
the desired direction.

 Tighten all sections of the pipe union.

1.

2.

3.

4.

1.

2.

3.

4.

Pipe plugs

Explosion-proof
enclosure

3/4-in. to 1-in.
pipe adapter

1-in. pipe union

Cable
assembly

Magnetic pickup

Turbine flowmeter

Figure 2.1—Connection of MC-III EXP to a 
flowmeter

Caution:  Do not use Teflon® tape on 
threads of the union, adapter, or 
pipe plugs. Use of Teflon® tape 
will void the explosion-proof 
rating of the instrument.



12

Section 2 MC-III™ EXP Flow Analyzer 

Instrument Dimensions
The MC-III EXP may include either of two enclosure styles. The standard enclosure shown on the cover of 
this manual and in Figure 2.2 features mounting holes on either side of the display window, allowing it to be 
mounted to a flat bulkhead.

The alternate enclosure (Figure 2.3) does not have the bulkhead mounting holes on the sides, and a bright red 
ring frames the display window. The alternate enclosure is slightly taller than the standard enclosure.

5.71 (145)

6.73
(171.1)

1.75
(44.5)

5.00 (127)

 
Figure 2.2—Mount dimensions in inches (millimeters) with standard enclosure

 
Figure 2.3—Mount dimensions in inches (millimeters) with alternate enclosure
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Field Wiring Connections

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.    

To wire the MC-III EXP for operation, complete the following field connections:

 Unscrew the cover of the enclosure counter-clockwise until it separates from the main body of the enclo-
sure. 

 Using a small standard blade screwdriver, remove the two #4-40 × 7/8” screws located to the right and 
left side of the display.  

 Lift the display/keypad assembly from the enclosure, making sure the circuit assembly does not contact 
the enclosure.  

 Connect the lithium battery or alkaline battery pack to the J1 connector on the circuit assembly.

 Connect wiring for external power, if appropriate. See Figure 2.4, page 14.

 Connect the flowmeter or pulse input wiring to terminal block TB1. See Figures 2.5 and 2.6, page 15. 

 Connect wiring for the remote reset input to terminal block TB1, if appropriate. See Figures 2.7 and 2.8, 
page 16.

 Connect wiring for output signals, if appropriate. See Figures 2.9 through 2.14, pages 17 through 20.

 Place the circuit assembly over the standoffs and fasten with the two #4-40 × 7/8” screws, ensuring that 
all connector wiring is inside the enclosure and in no position where it may be damaged when the enclo-
sure cover is replaced.

 Recalibrate the MC-III EXP (if necessary). 

 If external and internal power supplies were removed, reset the clock to ensure that the time stamps in the 
log data are accurate. The clock is reset using the MC-III interface software. See Time/Date Synchroniza-
tion, page 50.

 Replace the enclosure cover by threading it onto the enclosure in a clockwise direction.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.
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Power Supply Wiring
Internal Power Supply
The MC-III EXP is shipped with either of two internal power supplies:

a 3.6-V lithium battery or
a shrink-wrapped alkaline battery pack containing three C-size industrial-grade batteries

Low-power microprocessor technology enables the MC-III EXP analyzer to operate approximately 2 years on 
a single lithium battery. The lithium battery is strongly recommended for use in extreme temperatures (below 
-20°C).

Users can power the instrument from an external power supply or a 4-20 mA current loop, and use the lithium 
or alkaline battery as a backup power supply. The use of an alternate power source extends battery life and 
helps ensure that timekeeping and volume accumulation will not be interrupted during a power failure.

Caution:  If the MC-III EXP is installed in a hazardous location, all field wiring must conform to wir-
ing methods for explosion-proof installations as defined in the National Electric Code for 
installations within the United States or as specified in the Canadian Electric Code for 
installations within Canada.  State and local wiring ordinances may also apply.

External Power Supply 
 The MC-III EXP can be connected to a remote power supply by a two-conductor cable (Figure 2.4).  The 
power supply and cable must be capable of supplying 6 to 30 VDC @ 10 mA. This capability is available 
only if the 4-20 mA rate output is not used.

Caution:  When using the amp & square output with the external power supply, make sure the 
power supplies for both features share a common negative (-) terminal or that they are 
totally isolated from each other, since both share a common negative (-) connection.

TB
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E
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T
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T
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T

TF
M

A&S
GND

EXT POWER

TB2

RS485
SLAVE

4-20
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PULSE
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6-3
0 V

DC

P O W E R  
S U P P LY
6 to  30 

V D C

J1

J2

RESET 
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BA
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Y

Figure 2.4—External power supply wiring

•
•
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Input Wiring
Turbine Flowmeter (TFM) Input
The TFM input provides the turbine flowmeter input signal generated by a magnetic pickup, enabling the MC-
III  to calculate and display instantaneous flow rates and accumulated totals.
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TT
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Figure 2.5—Flowmeter input wiring

Pulse Input
The pulse input provides an optically isolated input in systems where a preamplifier is inserted between the 
sensor and the MC-III EXP.
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Figure 2.6—Pulse input wiring
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Remote Reset Input
The remote reset input allows the operator to reset the accumulated volume on the MC-III EXP to zero 
without opening the enclosure. This input is optically isolated. The input is shown connected in two ways, 
with a power supply and switch in a remote location (Figure 2.7), and with a pulse generator in a remote 
location (Figure 2.8). The remote reset input can also be controlled with an optional explosion-proof switch 
mounted in the top of the enclosure. See Appendix A for installation and wiring instructions. 

The reset input, reset pulse, or local reset switch must be active for 3 seconds to clear the total. (The 
explosion-proof switch  can also be used to view daily logs and to save the accumulated volume to memory 
without opening the enclosure. See Explosion-Proof Reset/Control Switch, page 7, for more information.)
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Figure 2.7—Reset input wiring (when power supply and reset switch are in a safe area)
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Figure 2.8—Reset pulse input wiring (when pulse generator is in a safe area)
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Output Wiring
The MC-III EXP supports four outputs: pulse output, 4 to 20 mA output, flowmeter frequency (amp & square) 
output, and RS-485 output. Wiring diagrams for each feature are provided below. 

Pulse Output 
The pulse output is a solid-state relay. Each pulse represents a user-defined volume. Because the circuit is 
isolated, it can be used in conjunction with any other feature on the MC-III EXP.  A two-conductor cable from 
the MC-III EXP to the remote location is required (Figure 2.9).  The maximum current rating of the pulse 
output circuit is 60 mA at 50 VDC. 

For information on configuring the pulse output with the keypad, see page 32. For information on configuring 
the pulse output with the interface software, see page 64. 
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Figure 2.9—Pulse output wiring

Analog (4-20 mA) Rate Output 
The 4-20 mA rate output provides a linear current output that represents flow rate. This output requires a two-
conductor cable connected to an 8 to 30 VDC power supply (voltage required is dependent on loop resistance) 
and a current readout device located in the remote location.  The 4-20 mA rate output current loop also powers 
the MC-III EXP.  The internal battery (lithium or alkaline) provides a power supply backup to maintain 
timekeeping accuracy and to continue accumulating volume in the event that the 4-20 mA current loop fails.  

Figure 2.10, page 18, shows the minimum required voltage to  power the instrument for a given loop 
resistance. In addition, the mathematical relationship between loop voltage and load resistance is given. For 
example, if a power supply voltage of 24 volts is available to power the current loop, the maximum load 
resistance would be 800 ohms.

Caution:   The 4-20 mA rate output and the flowmeter frequency output circuits are not isolated 
from each other and cannot be used simultaneously. When the 4-20 mA output option is 
used, do not connect external power to TB3.  

For information on configuring the 4-20 mA rate output with the keypad, see page 29. For information on 
configuring the 4-20 mA rate output with the interface software, see page 60.
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Figure 2.10—4-20 mA rate output wiring

Flowmeter Frequency Output
The flowmeter frequency (amp & square) output provides an open drain transistor output at the turbine meter 
frequency, which may be used to provide flow rate and/or total information to peripheral equipment. The 
output requires a two-conductor cable from the MC-III EXP to the remote frequency readout device requiring 
50 mA or less and a 5 to 30 VDC power supply (Figure 2.11, page 19). 

Caution:  The flowmeter frequency output and 4-20 mA rate output are not isolated from each other 
and cannot be used simultaneously.

Caution:   When using the flowmeter frequency output and powering the device from an  
external power supply,  make sure both power supplies share a common negative (-) 
terminal or are totally isolated from each other. 

The flowmeter frequency output terminals on the MC-III EXP circuit assembly are labeled A & S to represent 
“amp & square” output.
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Figure 2.11—Flowmeter frequency (amp & square) output wiring

RS-485 Output
The RS-485 output is required for communication with the interface software. Wiring diagrams are provided 
for a permanent connection (Figure 2.12), as well as for temporary laptop connections using an RS-485 to RS-
232 converter (Figures 2.13 and 2.14, page 20).

Additionally, the RS-485 output is approved for intrinsically safe installations. An intrinsically safe 
installation requires an intrinsically safe barrier assembly with a conduit seal (Figure 2.15, page 21). In such 
installations, only the turbine flowmeter input may be used.
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Figure 2.12—RS-485 output (permanent connection)
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Figure 2.13—RS-485 output (connection to laptop with 9-pin converter)
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Figure 2.15—Intrinsically safe RS-485 connection, based on control drawing 9A-50053010
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Section 3—Configuration and Operation via Keypad
Calibration of the MC-III™ EXP is a simple matter of entering necessary parameters into the instrument. 

The process for calibrating the MC-III EXP depends on how the instrument will be used. The keypad can 
be used to calibrate the MC-III EXP for liquid or gas measurement using preprogrammed units, or for liquid 
measurement using a calculated divisor. When preprogrammed units are used, the MC-III EXP automatically 
calculates the divisor for volume calculation and the rate multiplier for flow rate calculation, making 
calibration quick and easy.

Important: For compensated gas measurement, or gas or liquid measurement requiring multipoint 
(2- to 12-point) linearization, calibration must be performed with the software user inter-
face (see Section 4).

Because the keypad is protected beneath the lid of the instrument, the enclosure must be opened to access the 
keypad. For this reason, it is important to calibrate the instrument before installing it in a hazardous area. 

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.   

The following parameters can be configured using the six-button keypad on the front of the instrument:

calibration factor and unit
units of measurement for Total and Rate displays
decimal position for Total and Rate displays  
input type and sensitivity level
4-20 mA output
pulse output scale factor
slave address
baud rate

•
•
•
•
•
•
•
•
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Entering a Calibration Factor 
When the volume is to be expressed in barrels (BBL), gallons (GAL), liters (LIT), cubic meters (M3), or cubic 
feet (CF), and the flow rate is to be expressed in barrels, gallons, liters, cubic meters or cubic feet per day, per 
hour, per minute, or per second, the MC-III EXP calculates the divisor automatically; only the turbine meter 
calibration factor is required.

When the volume is to be expressed in a unit other than the preprogrammed units listed above, a calculated 
divisor must be entered at the K-Factor prompt. See Entering a Calculated Divisor, page 25.

To Enter a Calibration Factor:
Enter the K-Factor menu. Press K-FACTOR MENU.

K-FACTOR
MENU 00000000

M3

BBL
GAL
LIT

CF
CF

X1000
X1000

Select the unit of measure associated 
with the calibration factor (typically, 
pulses per gallon).

Press UP ARROW until the correct 
unit is displayed.

TEST

Enter the decimal point position for 
the calibration factor.

Press LEFT ARROW to select the 
decimal point.

LOG 00000000
M3

BBL
GAL
LIT

CF
CF

X1000
X1000
.

Press UP ARROW to change the 
position of the decimal point. 

TEST

Press LEFT ARROW to save the 
decimal point position and proceed 
with entering a calibration factor.

LOG

Enter the calibration factor, starting 
with the last digit and entering digits 
right to left.

Press UP ARROW until the last digit 
of the calibration factor is displayed.

TEST 00000000
M3

BBL
GAL
LIT

CF
CF

X1000
X1000

Press LEFT ARROW to select the 
next digit to the left. 

Repeat using UP and LEFT arrows to 
enter all remaining digits.

LOG

Press ENTER.
SAVE

ENTER

The Input Sensitivity menu will appear following the entry of the calibration factor.  See Setting Input Type 
and Sensitivity, page 26, for the input sensitivity configuration procedure.
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Entering a Calculated Divisor
When registering the volume in units other than cubic meters, cubic feet, barrels, gallons, or liters, a 
calculated divisor must be entered in the K-Factor menu instead of the turbine meter calibration factor. 

Important: When a calculated divisor is used, the units for both the volume display and the volume 
portion of the flow rate display should be set to USER (no units visible on the display). 

The divisor and divisor decimal point must be determined, then entered in the K-Factor menu.  

The formula for calculating the divisor is:

Divisor = FC × CON

Where:

FC = meter factor in pulses per gallon (P/G) 
CON = the conversion factor for number of gallons per unit volume of desired measure

To Enter a Calculated Divisor:
Enter the K-Factor menu. Press K-FACTOR MENU.

K-FACTOR
MENU

Select no unit of measure. Press UP ARROW until no unit is 
displayed (as shown).

TEST 00000000 M3

BBL
GAL
LIT

CF
CF

X1000
X1000

Enter the decimal point position for the 
calculated divisor.

Press LEFT ARROW to select the 
decimal point.

LOG 00000000 M3

BBL
GAL
LIT

CF
CF

X1000
X1000
.

Press UP ARROW to change the 
position of the decimal point.

TEST

Press LEFT ARROW to save the 
decimal point position and proceed 
with entering a calculated divisor.

LOG

Enter the calculated divisor, starting 
with the last digit and entering digits 
right to left.

Press UP ARROW until the last digit 
of the calculated divisor is displayed. 

TEST 00000000 M3

BBL
GAL
LIT

CF
CF

X1000
X1000Press LEFT ARROW to select the 

next digit to the left. 

Repeat using UP and LEFT arrows to 
enter all remaining digits.

LOG

Press ENTER.
SAVE

ENTER

The Input Sensitivity menu prompt will appear immediately following the entry of the calibration factor. See 
Setting Input Type and Sensitivity, page 26, for the input sensitivity configuration procedure.
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Setting Input Type and Sensitivity
The flowmeter signal can be obtained from a magnetic pickup or a pre-amplifier device. 

The input sensitivity of the MC-III EXP is measured in millivolts (mV) peak-to-peak. This is the threshold 
value at which the circuitry responds to a signal. If the input signal is less than this value, the MC-III EXP will 
not count the electrical pulses as a valid turbine meter signal.  If the input signal is equal to or greater than this 
value, the electrical pulses received at the input will be counted. Care must be taken to ensure that the input 
sensitivity is high enough to reject any electrical noise on the signal line, but not so high that flowmeter pulses 
are missed. The input sensitivity of the MC-III EXP may be set to low, medium, or high when the input will 
be provided by a turbine flowmeter. 

If the input will be provided in the form of a pulse from a pre-amplifier or other device (rather than directly 
from a turbine flowmeter), the “Pulse In” (pulse input) setting in the Input Sensitivity menu should be 
selected.

See Section 2 for input wiring diagrams.

 
To Set Input Type and Sensitivity:
Enter the K-Factor menu. Press K-FACTOR MENU.

K-FACTOR
MENU

Locate the input sensitivity setting. Press ENTER, repeatedly if 
necessary, to bypass calibration 
factor.

SAVE

ENTER

If the input is the turbine meter, select 
a sensitivity setting: low, medium, or 
high. 

If the input is provided by a different 
device, such as a pre-amplifier, select 
“Pulse in” (for pulse input).

Press UP ARROW to select a 
sensitivity setting.

TEST

Select low, medium,
high, or Pulse In

Press ENTER. “SAVING” will appear 
in the bottom display.

SAVE

ENTER
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Configuring the Total Display
The Total display can be configured for measuring volume in any of five preprogrammed units, any 
preprogrammed unit times 1,000, or a user-defined unit.

Users ca specify a decimal point position ranging from 0.1 to 0.0001 of a unit.

To Configure the Total Display:
Enter the Display menu. Press DISPLAY MENU. DISPLAY

MENU

Select the unit of measure in which 
volume will be displayed.

Press UP ARROW until the correct 
unit is displayed. 
Note—If a calculated divisor was 
entered, select user-defined (no units 
visible).

TEST 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

To read the volume in terms of 
thousands of units (ex. 1.0 = 1,000 
bbl), continue pressing UP ARROW  
until both the unit of choice and the 
X1000 option are displayed.

TEST 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

Enter the decimal point position. Press LEFT ARROW three times, 
or until the decimal point in the Total 
display begins blinking. 

LOG 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

.
Press UP ARROW to change the 
position of the decimal point.

TEST

Press ENTER. “SAVING” will appear 
in the bottom display.

SAVE

ENTER

Important: Before enabling or disabling the “× 1000” unit option for displaying flow totals, clear the 
total display to zero. If the total is not cleared, the accumulated total displayed will repre-
sent a combination of two different units and will not provide an accurate flow reading.
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Configuring the Rate Display
The Rate display comprises two parts: a volume unit and a time-base unit. The volume portion of the Rate 
display can be configured in one of five preprogrammed engineering units or in a user-defined unit (for 
use with a calculated divisor). To display the volume portion in multiples of 1,000 units, continue scrolling 
through the volume unit options until the ×1000 entry is displayed, along with the appropriate unit of 
measure. 

The time-base portion of the Rate display can be configured in one of four preprogrammed engineering units: 
per day, per hour, per minute, or per second. 

Users can specify a decimal point position, ranging from no decimal up to 0.001 of a unit.

To Configure the Rate Display:
Enter the Display menu. Press DISPLAY MENU. DISPLAY

MENU

Enter the volume factor used to 
express flow rate (Ex.: bbl in bbl/day).

Press LEFT ARROW. The volume 
unit of measure in the bottom portion 
of the LCD window should begin 
blinking.

LOG 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

Press UP ARROW until the desired 
volume unit of measure is displayed. 
Note—If a calculated divisor was 
entered, select user-defined (no units 
visible).

TEST

Enter the time-base factor used to 
express flow rate (Ex. /day in bbl/day). 

Press LEFT ARROW. The time-base 
factor in the bottom portion of the 
LCD window should begin blinking.

LOG 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

Press UP ARROW until the desired 
time-base factor is displayed.

TEST

Enter the decimal point position. Press LEFT ARROW twice, or until 
the decimal point in the Rate display 
begins blinking. 

LOG 00000000
000000

M3

BBL
GAL
LIT

M3

BBL
GAL
LIT

/SEC
/MIN
/HR
/DAY

CF
CF

X1000
X1000

STANDARD

.
Press UP ARROW to change the 
position of the decimal point.

TEST

Press ENTER. “SAVING” will appear 
in the bottom display.

SAVE

ENTER
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Configuring the 4-20 mA Rate Output

Caution:  Before performing any 4-20 mA configuration, ensure that all peripheral equipment con-
nected to the 4-20 mA current loop is either disconnected or disabled.  Configuring and 
testing the 4-20 mA output feature on the MC-III EXP with the peripheral equipment in 
operation may cause false alarms or erroneous operation of the peripheral device or as-
sociated equipment.

The MC-III EXP has a 4-20 mA output feature that represents flow rate. Zero and full-scale values can be 
configured to represent any flow rate range within the range of the flowmeter.  

The low (or zero) setting is the flow rate value that will produce a 4-mA output. The high (or full-scale) 
setting is the flow rate value that will produce a 20-mA output. Typically, the high value is greater than the 
low value; this scenario is defined as “direct mode” in Figure 3.1. 

Alternatively, users may configure the 4-mA and 20-mA outputs to have an inverse relationship, such that the 
high value is less than the low value. This scenario is defined as “indirect mode” in Figure 3.1.

Figure 3.1—Two options for configuring a 4-20 mA output

See Section 2 for instructions on installing and wiring the 4-20 mA rate output.
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Flow rates in-between the minimum and maximum rate setpoints will result in an output of current between  
4 mA and 20 mA according to the following calculation:

[ ] [ ]MAX MIN
OUT CURR MIN

I I
I RATE Low I

High Low
−

= × − +
−

Where:

IOUT = output current 

IMAX = maximum current output (20 mA)

IMIN = minimum current output (4 mA)

High = programmed flow rate that produces a 20-mA output

Low = programmed flow rate that produces a 4-mA output

RATECURR= flow rate
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To Configure the 4-20 mA Output:
Enter the Output menu. Press OUTPUT MENU. OUTPUT

MENU

Enable or disable the 4-20 mA output. Press UP ARROW to toggle output to 
“on” or “off”. 

TEST

Toggles between
“off” and “on”

Press ENTER. If the 4-20 mA output 
is enabled, the LCD will display the 
“Low” flow rate and the decimal point 
in the numeric display will begin 
blinking.

SAVE

ENTER

Enter the decimal point position for the 
“Low” flow rate. The words “4-20 mA 
LOW” should appear at the bottom of 
the LCD.

Press UP ARROW to change the 
position of the decimal point.

TEST 00000000
/MIN

CF

.

Enter the “Low” (4-mA) flow rate. 
Digits are entered from right to left.

Press LEFT ARROW until the 
rightmost digit in the top display 
begins blinking.

LOG 00000000
/MIN

CFPress UP ARROW to change the 
digit.

TEST

Press LEFT ARROW to select the 
next digit to the left. 
Continue pressing UP ARROW and 
LEFT ARROW alternately to enter all 
remaining digits.

LOG

Press ENTER. The LCD will display 
the “High” flow rate and the decimal 
point in the numeric display will begin 
blinking.

SAVE

ENTER

Enter the decimal point position for the 
“High” flow rate. The words “4-20 mA 
HIGH” should appear at the bottom of 
the LCD.

Press UP ARROW to change the 
position of the decimal point.

TEST 00000000
/MIN

CF

.

Enter the “High” (20-mA) flow rate. 
Digits are entered from right to left.

Press LEFT ARROW until the 
rightmost digit in the top display 
begins blinking.

LOG 00000000
/MIN

CFPress UP ARROW to change the 
digit.

TEST

Press LEFT ARROW to select the 
next digit to the left. 
Continue pressing UP ARROW and 
LEFT ARROW alternately to enter all 
remaining digits.

LOG

Press ENTER.
SAVE

ENTER

The Pulse Output menu prompt will appear immediately following the entry of 4-20 mA parameters. See 
Configuring the Pulse Output, page 32, for the pulse output configuration procedure. 
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Configuring the Pulse Output
The pulse output feature of the MC-III EXP is typically disabled to reduce current consumption. When the 
pulse output is not needed, Cameron recommends that this feature be disabled. 

If the pulse output feature is required, the user will be prompted to enter a pulse output scale factor, which is 
the volume increment that will cause a pulse output to occur. 

If the pulse output is configured via interface software instead of via the keypad Output menu, the user can 
also specify a pulse length (pulse width), which determines the length of each output pulse in milliseconds 
(ms). This parameter is configurable only with the interface software. See Section 4 for more information.

See Section 2 for instructions on installation and field wiring of the pulse output feature.

To Configure the Pulse Output:
Enter the Output menu. Press OUTPUT MENU. OUTPUT

MENU

Locate the Pulse Output setting. Press ENTER repeatedly until the 
words “Pulse Output” appear in the 
lower display.

SAVE

ENTER

Enable or disable the pulse output. Press UP ARROW to toggle output to 
“on” or “off”. 

TEST

Toggles between
“off” and “on”

Press ENTER. If the pulse output is 
enabled, the LCD will display “Pulse 
Output Scaler” and the decimal point 
in the numeric display will begin 
blinking.

SAVE

ENTER

Enter the decimal point position for the 
output scale factor.

Press UP ARROW to change the 
position of the decimal point.

TEST 00000000 M3

BBL
GAL
LIT

CF X1000

...
.

Enter the pulse output scale factor. 
Digits are entered from right to left.

Press LEFT ARROW until the 
rightmost digit in the top display 
begins blinking.

LOG 00000000 M3

BBL
GAL
LIT

CF X1000

...Press UP ARROW to change the 
digit.

TEST

Press LEFT ARROW to select the 
next digit to the left. 

Repeat using UP and LEFT arrows to 
enter all remaining digits.

LOG

Press ENTER.
SAVE

ENTER

The Slave Address menu prompt will appear immediately following the entry of pulse output parameters. See 
Entering the Slave Address, page 33, for information on entering the slave address.
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Entering the Slave Address
The slave address is a setting used in Modbus® communications. It is a number that ranges from 1 to 65535, 
excluding 252 to 255 and 64764. If the Modbus® request message contains the matching address, the 
device will respond to the request. In network arrangements, the device must have a unique slave address. 
For more information about Modbus® communications, refer to the protocol manual section. If Modbus® 
communications are not used, leave the slave address at the factory setting (1).

To Enter Slave Address:
Enter the Output menu. Press OUTPUT MENU. OUTPUT

MENU

00000000
...

00000000
...

00000000
...

00000000
...

Locate the Slave Address setting. Press ENTER until the words “Slave 
Address” appear in the lower display.

SAVE

ENTER 00000000
...

The rightmost digit in the top display 
will begin blinking.

Enter the Slave Address. 
(range: 1 to 65535, excluding 252 to 
255 and 64764)

Press UP ARROW until the correct 
digit is displayed.

TEST

Then press LEFT ARROW to select 
the next digit to the left. 

Repeat using UP and LEFT arrows to 
enter all remaining digits.

LOG

Press ENTER.
SAVE

ENTER

The Baud Rate menu prompt will appear immediately following the entry of the slave address. See Entering 
the Baud Rate below for the baud rate entry procedure.

Entering the Baud Rate
The baud rate is the number of bits per second that are on the serial port. This setting must match the setting 
of the master device polling the MC-III EXP or the serial port. This only applies to the Modbus® communica-
tions; if Modbus® communications are not used, leave the baud rate at the factory setting (9600).

To Enter the Baud Rate:
Enter the Output menu. Press OUTPUT MENU. OUTPUT

MENU

Locate the Baud Rate setting. Press ENTER repeatedly until the 
words “Baud Rate” appear in the 
lower display.

SAVE

ENTER 115200

Enter the baud rate. Press UP ARROW until the correct 
baud rate is displayed.

TEST

Press ENTER. “SAVING” will appear 
in the bottom display.

SAVE

ENTER
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Section 4—Configuration and Operation via Software
The MC-III™ interface software provides easy access to all configuration parameters and is the quickest way 
to configure the device. Instead of navigating keypad menus, users enter configuration parameters with their 
computer keyboard. 

While basic parameters can be configured with the keypad (see Section 3), the interface software is the 
only means of accessing every configurable parameter. For example, multipoint calibration for liquid or 
gas measurement and gas volume correction parameters for measuring gas in standard cubic feet must be 
configured via the interface software.

Table 4.1, page 45, provides a quick reference for determining whether a configurable parameter is accessible 
through both the keypad menu and the interface software, or only through the interface software. 

Installing the Software
The MC-III interface software is stored on a CD that is shipped with each instrument, and it installs directly 
onto a PC or laptop. To install the interface software on a computer, perform the following steps:

 Place the MC-III CD in your CD-ROM drive.

 The MC-III install screen will load automatically. 

 Click on “Next” to initiate the installation, and follow the instructions on the screen. An MC-III icon  
(Figure 4.1) will appear on the desktop of the user’s PC or laptop when installation is complete.

To access the interface software, click on the MC-III icon on your desktop or go the Start menu and select 
Programs>NuFlo>MC-III>MC-III.

Figure 4.1—MC-III desktop icon

Accessing Help
The Help menu, accessible from the task bar at the top of the Welcome screen (Figure 4.2, page 36), provides 
easy access to documentation designed to assist the user in installing, configuring, and operating the MC-III 
EXP flow analyzer. This documentation includes:

a “read me” file for general reference (includes contact information for technical assistance)
an electronic copy of the user manual
an electronic copy of the quick-start guide for installing and configuring the MC-III EXP
a COM troubleshooting guide for addressing communications errors (this guide will automatically display 
on screen when a communication error is detected)

1.

2.

3.

•
•
•
•
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Connecting to the Software

Important: Before attempting to load the interface software, verify that the MC-III EXP is connected 
to a computer with an RS-485 to RS-232 converter (see Optional Parts List, page 93). See 
Section 2 for RS-485 output wiring diagrams (Figures 2.12 through 2.14, pages 19 and 20). 

Once the software is installed, the program will automatically launch with the click of the NuFlo MC-III icon 
on the desktop. 

To connect to the MC-III software, perform the following steps:

 Click on the NuFlo MC-III icon on the desktop, or select Start>Programs>NuFlo>MC-III>MC-III. The 
Welcome screen (Figure 4.2) will appear and a Select COM Port window will prompt the user to select a 
communications port be used for connecting with the MC-III EXP (Figure 4.2).

 Select a communications port from the dropdown list and click “OK.” The software will attempt to con-
nect with the MC-III EXP (via an RS-485 to RS-232 converter). This automatic launch feature is referred 
to as an “express connect.”

 If the internal time and date programmed into the instrument differs from the time and date displayed on 
the computer by more than 60 seconds, the software will prompt the user to synchronize the instrument 
time/date to match the computer time/date (Figure 4.3, page 37). This ensures that the instrument displays 
correct time, regardless of time zone differences.

Figure 4.2—Select COM Port window

1.

2.

3.
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Figure 4.3—Prompt for authorizing time and date synchronization

The time difference setting used to generate a synchronize prompt is user-configurable. For more information, 
see General Options, page B-1.

Automating Functions on Software Startup
When the software connects with the instrument, the Device Autorun Options screen appears (Figure 4.4).  
From this screen, users can configure the instrument, download logs, or upload previously saved configuration 
settings.

A checkbox at the bottom of the Device Autorun Options screen allows the user to bypass the Device Autorun 
Options screen and perform a selected function each time the software connects to the instrument. 

Example: To download all logs on connection, select Download all logs from the Device Autorun Options 
screen and check the “Always do...” checkbox. Each time the software computer connects to the instrument, 
the software will bypass the Device Autorun Options screen, open the Flow Archive screen, and download all 
logs. See Section 5 for more information on flow logs.

Figure 4.4—Device Autorun Options screen
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Changing Autorun Settings
To change an autorun setting —that is, to initiate an autorun action, to terminate an autorun action, or to 
change to a different autorun action—without exiting to the Welcome screen, choose Options/Program 
Options from the menu bar and select Autorun from the dropdown list (Figure 4.5).

Figure 4.5—Options/Program Options screen for changing autorun settings

Express Connect Option
By default, the MC-III EXP interface software automatically attempts to connect to the instrument when a 
user clicks on the desktop application icon. For more information on disabling the “express connect” feature 
and changing communications options, see Appendix B. 

Canceling Express Connect
To temporarily cancel the “express connect” function without exiting the software program, click in the LCD 
area of the device on the Welcome screen or choose File>Cancel Express Connect from the menu bar (Figure 
4.6, page 39). The software will stop all attempts to connect to the device. The “express connect” function 
will be restored when the user exits the program and attempts to re-open the software.



39

MC-III™ EXP Flow Analyzer  Section 4

Figure 4.6—Cancel Express Connect option

To reattempt a connection to the device after canceling the “express connect” function, click the LCD on the 
Welcome screen again, or choose File>Express Connect from the menu bar.

Changing the Communications Port
The computer will attempt to connect to the MC-III EXP via the port that the user selects the first time 
he connects to the instrument. However, if a network dictates that the computer connect through another 
communications port (actual or virtual), the user must specify the appropriate COM port. To change the COM 
port setting, click on Options>Select COM Port (Figure 4.7), and select the appropriate COM port from the 
list of ports detected.

Figure 4.7—COM port selection menu

Software Connection in Multi-Device Network
In most cases, the automatic launch (or “express connect”) feature is a convenient time-saver. However, if 
multiple devices are daisy-chained together in a network, this feature can interfere with the user’s ability to 
connect to a specific device. The MC-III allows the user to temporarily disable the “express connect” feature 
and query the system for all connected devices. From the resulting list of devices, the user can then connect to 
the appropriate slave address.
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To select a device from a network of instruments, perform the following: 

 From the Welcome screen, choose File>Cancel Express Connect (Figure 4.6, page 39). 

 Click File>Discover Modbus® Slaves.

 Enter a range of addresses you want to search (Figure 4.8).

 Enter the baud rate established for network communications.

 Adjust the time-out setting, if necessary.

 Click “Search.” The software will scan all addresses specified and display all instruments connected.

 Click on the appropriate address to connect to a device.

Note: In daisy-chain configurations, verify that each device has a unique slave address.

Figure 4.8—Automatic detection of all connected devices

A user who knows the address of a specific device may also connect to it by clicking File>Connect Device at 
Address (Figure 4.9, page 41).

1.

2.

3.

4.

5.

6.

7.
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Figure 4.9—Slave address selection screen

Setting Log Download Preferences
The MC-III EXP automatically saves daily flow logs on the contract hour, and hourly flow logs around the 
clock. The instrument also automatically creates an event record each time a user change is made. After 
downloading these logs from the instrument, the instrument saves the data in a file. By default, the logs are 
saved as .csv files. 

The file format of the auto-save flow log and event log files is user-configurable. Users can configure the 
instrument to download the auto-save flow and event logs as Excel (.xls) files by selecting Options>Program 
Options>Downloading from the menu bar (Figure 4.10). 

Figure 4.10—Log file type selection
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Configuring the MC-III EXP
The MC-III EXP offers three methods for configuring parameters: 

The  “Configuration Wizard” (Figure 4.11) condenses the configuration process into nine easy-to-follow 
steps (compensated gas measurement and multipoint linearization are not supported in the wizard).
The MC-III Main screen (Figure 4.12, page 43) gives users complete access to all configuration param-
eters.
The Advanced screen (Figure 4.13, page 43) provides access to Modbus® registers that can be modified to 
change configuration parameters (recommended only for system configurators and host programmers).

If the desired configuration settings have been saved previously, the configuration file can also be uploaded, 
eliminating the need to re-input configuration data. See Saving and Uploading Configuration Files, page 66, 
for details.

Figure 4.11—Configuration Wizard (for novice users) 

•

•

•
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Figure 4.12—MC-III Main configuration option for complete access to configurable parameters

Figure 4.13—Advanced Access configuration option for system configurators and host programmers
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Configuration Wizard
The Configuration Wizard is ideal for first-time users who want to perform a basic calibration for liquid or gas 
measurement. By following the instructions on nine screens, even a first-time user can successfully configure 
the MC-III EXP.

See Table 4.1, page 45, for a list of settings that are configurable with the keypad, the software Configuration 
Wizard, and the software MC-III Main Screen. 

Important: The Configuration Wizard does not allow multipoint calibration or gas volume  
correction. To select these parameters, the user must access the MC-III Main screen.

Caution:  Do not use the Configuration Wizard to change individual settings. When the Configura-
tion Wizard is used, system default settings are restored before the new settings entered 
in the Calibration Wizard are written to the program. Previous configuration settings are 
saved automatically in C:\NuFlo log data\MC-III\Config Backup Files.

Using the Pencil Tool
The data entry fields in the Configuration Wizard are highly intuitive, and most can be completed by clicking 
in the field and entering new data or selecting a checkbox. For data fields that require the user to enter a value, 
such as a K-factor, and designate a decimal position, a pencil icon provides a link to a data-entry window. 

To enter a new value, click on the pencil icon (Figure 4.14). A new window will appear, allowing the user 
to enter a new value, and designate the appropriate decimal position using a slide bar. This method ensures 
that the decimal point setting and data-entry resolution displayed in the software and on the instrument LCD 
correlate.

This tool is used to enter the calibration factor, flow rates for 4-20 mA output, and the scale factor for pulse 
output.

Figure 4.14—Pencil tool icon and data-entry window 
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Table 4.1—Menus for Configuring Parameters

Configurable Parameter Instrument 
Keypad

Configuration 
Wizard

Menu Screen
(accessed from 

MC-III Main)

For 
information, 
see page … 

Well Name — Step 1 Wellsite 
Information

53

LCD Contrast — — System Setup 50
Security Setup — — System Setup 51
Contract Hour — Step 2 System Setup 50
Volume Display (units, 
decimal location)

Yes Step 5 Turbine Input 54

Rate Display (units, decimal 
location)

Yes Step 5 Turbine Input 54

Input Type Yes Step 3 Turbine Input 55
Input Sensitivity Yes — Turbine Input 55
Input Cut-off Thresholds — — Turbine Input 55
Calculation Period (seconds) — — Turbine Input 55
K-Factor Yes Step 4 K-Factor Entry 56
Multipoint K-Factor — — K-Factor Entry 57
Gas Volume Correction — — K-Factor Entry 58
4-20 mA Output Yes Step 6 4-20 mA Output 60
Pulse Output Yes Step 7 Pulse Output 63
Slave Address Yes Step 8 COM Port 51
Baud Rate Yes Step 8 COM Port 52
Bus Delay — — COM Port 52
Bus Timeout — — COM Port 53
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MC-III Main Screen
The MC-III Main menu screen (Figure 4.15) is the configuration hub of the MC-III EXP. From the Main 
screen, users can 

review all current instrument settings and flow readings
check the log archive and instrument status
access all submenus for changing configurable parameters
reset the total to zero

Figure 4.15—MC-III Main screen provides direct access to all menu functions using the scrolling menu bar at 
the left side of the screen. 

Data Display and Updates
Each time the software polls the instrument, a small icon appears briefly in the lower left corner of the screen.  
If the “Live Updates” checkbox in the lower right corner of the screen is checked, the instrument settings and 
the LCD displays will automatically update with each poll.

“Live Updates” Checkbox
The “Live Updates” option is enabled by default. However, in the event that slow communication speeds are 
used or the system times out frequently, the user can uncheck the “Live Updates” checkbox and periodically 
query the system by clicking on the LCD graphic on the Main screen. 

Reset Flow Total Button
The flow total can be reset to zero at any time by clicking on the “Reset Flow Total” button. 

Scroll Bar
A scroll bar at the left side of the screen (Figure 4.15) gives the user easy access to any of seven configuration 
menus and two log archive screens (see pages 48 and 49). Using these menus, the user can change all 
configurable parameters of the instrument. Once the instrument has been configured, the Main screen access 
should always be used for changing individual parameters while retaining all other configuration settings.

•
•
•
•
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Buttons and Tools
Apply and OK Buttons
Changing parameters on a submenu screen involves selecting the proper screen from the scroll bar, selecting 
information from dropdown menus or entering data in data fields, and saving the data using the “Apply” 
or “OK” button. “Apply” allows the user to apply the changes without leaving the submenu screen. “OK” 
allows the user to apply the changes and returns the user to the Main screen. 

Refresh and Cancel Buttons
To update the display of settings on any submenu screen by forcing a reread of configured parameters, press 
the “Refresh” button.  The “Refresh” button clears any entry that has not been applied, therefore, pressing 
“Refresh” is also a convenient way to erase an incorrect entry. A “Cancel” button allows the user to close out 
of a submenu screen without saving new settings and returns the user to the Main screen.

Pencil Tool for Data Entry
The data-entry fields in the MC-III Main sub-menu screens are highly intuitive, and most can be completed 
by clicking in the field and entering new data, or selecting a checkbox. For data fields that require the user 
to enter a value, such as a K-factor, and designate a decimal position, a pencil icon provides a link to a data-
entry window.

To enter a new value, click on the pencil icon (Figure 4.16). A new window will appear, allowing you to 
enter a new value, and designate the appropriate decimal position using a slide bar. This method ensures 
that the decimal point setting and data-entry resolution displayed in the software and on the instrument LCD 
correlate.

This tool is used to enter the calibration factor, flow rates for 4-20 mA output, and the scale factor for pulse 
output.

Figure 4.16—Pencil tool icon and data-entry window 
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Configuration Submenus (See Scroll Bar on MC-III Main Screen) 
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Configuration Submenus (cont’d) 



50

Section 4 MC-III™ EXP Flow Analyzer 

System Setup
The first of the submenus on the Main screen scroll bar—System Setup—allows users to adjust time/date, 
set the desired contract hour, enable or disable the password-protected security option, and adjust the LCD 
contrast. 

Figure 4.17—System Setup screen

Time/Date Synchronization 
The MC-III EXP includes a real-time clock for timekeeping and log time stamps. Upon connecting with 
the instrument, the interface software prompts the user to synchronize the instrument time and date with 
the time and date displayed on the computer if the time difference exceeds 60 seconds. To change the clock 
synchronization threshold to a value other than 60 seconds, see General Options, page B-1.

A user can synchronize the instrument and computer clocks at any time by clicking the “Sync to Computer 
Time” button on the System Setup screen.

Contract Hour
Hourly flow totals are logged in the archive on the hour. The contract hour determines the exact time when 
the daily flow total is logged. The contract hour is easily adjusted by selecting the appropriate hour from the 
dropdown list on the System Setup screen.

LCD Contrast Adjustment
LCD contrast is temperature-dependent and may require adjustment for optimum readout visibility. A slide 
bar allows users to quickly adjust the contrast of the LCD.
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Security Setup
Setting a keypad security code will prevent unauthorized personnel from altering calibration data or resetting  
totals, and the security function is recommended to preserve data integrity of the system. The MC-III EXP’s 
keypad security feature is disabled at the factory. 

To enable the security protection, check the “Keypad Lock” checkbox on the System Setup screen, and enter 
a four-digit lock code in the field below the checkbox. (Do not use “0000.”) The security feature will be 
activated the next time a user attempts to access the keypad.

Firmware Version Number
As firmware is upgraded, firmware version numbers change. The firmware version number shown may assist 
technical support personnel in troubleshooting an operational issue. 

Serial Number
The serial number of your MC-III EXP can be used to track the history of your unit to include warranty status. 

Communications Port
The Communications Port screen (Figure 4.18) allows users to change the settings that are required for 
Modbus® communication. 

Figure 4.18—Communications Port screen

Slave Address
The slave address allows the MC-III EXP to communicate with other devices via Modbus®. It is a number 
that ranges from 1 to 65535, excluding 252 to 255 and 64764. If a Modbus® request message contains the 
matching slave address, the device will respond to the request. In network arrangements, the slave device 
must have a unique address. For more information about Modbus® communications, refer to the protocol 
manual section. 
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To change the slave address, select a number using the “plus” and “minus” buttons on the screen, or using the 
page-up and page-down keys on your computer keyboard. If Modbus® communication is not used, leave the 
slave address at the factory setting (1).

Baud Rate 
The baud rate is the number of bits per second that are on the serial port. Baud rates supported by the MC-III 
EXP range from 300 to 115.2K. This setting must match the setting of the master device polling the MC-III 
EXP or the serial port. This only applies to the Modbus® communications; if Modbus® is not used, set the baud 
rate to 9600.

To change the baud rate, slide the selector bar to the appropriate setting. The default setting is 9600 baud. 
Note that the 9600 baud rate is available in both the low-power and high-power modes. When the instrument 
is powered by batteries alone, the low-power mode is recommended. 

Auto-Negotiate Option
When connected devices are capable of switching baud rates automatically or when devices are directly 
connected to an MC-III EXP, a user may configure the MC-III interface to automatically negotiate the fastest 
baud rate during device connection. This “negotiated” baud rate does not replace the configured baud rate, 
but rather provides a temporary boost of baud rate while the computer is connected to the device for faster 
downloads. After the software disconnects, the device reverts to the configured baud rate. 
 
By default, this function is disabled. To enable automatic baud rate negotiation on device connect, choose 
Options/Program Options from the menu bar, select Communications from the dropdown options list, check 
the “Attempt auto-negotiation...” checkbox, and click “OK” (Figure 4.19). To initiate an immediate search 
for the fastest baud rate without exiting tto the Welcome screen, check the “Enable auto-negotiated baud 
rate” checkbox, click the “Test Now” button to the right of the checkbox, and click “Yes” at the prompt in the 
Confirm dialog box. See also Auto-Negotiate Option, page B-4.

Figure 4.19—Communications Options screen 
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Bus Delay
Bus delay is the amount of time (in milliseconds) that passes before the MC-III EXP attempts to take control 
of the RS-485 bus and transmit a message back to the requesting device. The MC-III EXP responds very 
quickly to incoming Modbus® requests—in some cases, too quickly. A configurable delay allows the user to 
control this response time. A setting of 10 ms is normally sufficient, but may require adjustment when the 
MC-III EXP is communicating with a radio or other end device that responds more slowly.

Bus Timeout
Bus timeout is the amount of time (in milliseconds) that must pass to cause the MC-III EXP to reset its 
internal Modbus® message handler. The default value of 50 ms is normally sufficient.

Software Communication Options
The default timing parameters in the MC-III EXP support communication with most radios and Modbus® 
devices. However, if the MC-III EXP is used with a device that has a very slow response time, it may be 
necessary to adjust the timing parameters to enhance performance. For information about these parameters, 
see Appendix B, Software Program Options.

Wellsite Information
The Wellsite Information screen (Figure 4.20) allows users to enter information that distinguishes the wellsite, 
such as company name, well name, and site location. While most of the fields on this screen are optional, a 
well name should be assigned. 

The well name (limited to 20 characters in length) will also serve as the name of the folder where flow logs 
generated by the MC-III software will be archived. If a well name is not entered on this screen, logs will be 
saved in a folder titled “NO_WELLNAME.”

Figure 4.20—Wellsite Information screen
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Turbine Input
The Turbine Input screen (Figure 4.21) allows users to configure the displays for volume and rate, select the 
type of input to be used (turbine input or pulse input), determine cut-off thresholds for measuring flow, and 
determine the display update frequency.

Figure 4.21—Turbine Input screen

Volume Display
The Volume display can be configured to display totals in one of five preprogrammed engineering units or in a 
user-defined unit (for use with a calculated divisor). 

Important: If volume is to be measured in user-defined units, the K-Factor unit must also be  
entered as “pulses per unit.” For more information, see Entering a Calculated Divisor, page 
25.

To display the volume in multiples of 1,000 units, check the “Multiplier” checkbox. Users can specify 
decimal point position, from 0.1 to 0.0001 of a unit, using the slide bar on the Turbine Input screen.

Important: Before enabling or disabling the “× 1000” unit option for displaying flow totals, clear the 
total display to zero. If the total is not cleared, the accumulated total displayed will repre-
sent a combination of two different units and will not provide an accurate flow reading.

Rate Display
The Rate display comprises two parts: a volume unit and a time-base unit. The volume portion of the Rate 
display can be configured in one of five preprogrammed engineering units or in a user-defined unit (for use 
with a calculated divisor). To display the volume portion in multiples of 1,000 units, check the “Multiplier” 
checkbox. 
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The time-base portion of the Rate display can be configured in one of four preprogrammed engineering units: 
per day, per hour, per minute, or per second. Users can specify decimal point position, from no decimal up to 
0.001 of a unit, using the slide bar on the Turbine Input screen.

Important: If the volume portion of the Rate display is to be measured in user-defined units, the  
K-Factor unit must also be entered as “pulses per unit.” For more information, see  
Entering a Calculated Divisor, page 25.

Input Type and Sensitivity Configuration
The MC-III EXP accepts either a turbine input or a pulse input. When the turbine input is selected, the user 
can also specify one of three sensitivity levels (low, medium, or high) to help minimize noise interference in 
the signal reception. A “low” sensitivity setting will detect a signal of approximately 20 mV peak-to-peak, 
while a “high” sensitivity setting will detect only signals that exceed 40 mV, peak-to-peak.

When a pulse input is selected, no sensitivity setting is required.

Cut-Off Thresholds
Periods of very low or interrupted flow can lead to inaccuracies in indicated flow totals. To help prevent these 
inaccuracies, the user can establish cut-off thresholds to determine the minimum frequency and/or flow rate at 
which a signal will be recorded. 

The flow rate cut-off is a setpoint for the accumulation of flow time in the hourly and daily records, and can 
be applied to either a turbine input or pulse input.

The frequency cut-off is reserved for the turbine input only. When the low-frequency cut-off is configured, the 
MC-III EXP will ignore inputs that are less than the user-entered value. 

Calculation Period
The flow calculation period is the number of seconds that are allowed for calculating the flow condition. This 
setting is easily adjusted with the “plus” and “minus” buttons on the screen, or  the page-up and page-down 
keys on your computer keyboard. Increasing this setting value results in flow rates with greater resolution. 
This setting is also the time allowed for processing of display updates. 
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K-Factor Entry
The K-Factor Entry screen (Figure 4.22) allows users to calibrate the MC-III EXP using a single calibration 
factor from a turbine flowmeter or multipoint linearization. Users can also configure the MC-III EXP to 
compensate for the effect of pressure, temperature, and compressibility on gas volume measurements.

Figure 4.22—K-Factor Entry screen

K-Factor Units
K-Factor entry consists of selecting the K-Factor unit and type (linear or multipoint). In selecting the unit, 
users can choose from five preprogrammed units (pulses per gallon, barrel, cubic meter, cubic foot, or liter). If 
a calculated divisor is to be used, “pulses per unit” should be selected.

K-Factor Type
For linear calibration, the user need only select the Linear checkbox and enter the K-factor of the turbine 
meter. To enter the K-factor value, click on the pencil icon to open a data-entry window (Figure 4.23). Enter 
the digits, left to right, and adjust the slide bar to move the decimal point to the proper position. 

Figure 4.23—Data-entry screen for linear K-factor
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For multipoint calibration, the user selects the Multipoint checkbox, and then enters the number of calibration 
points he desires using the “plus” and “minus” buttons on the screen or the page-up and page-down keys on 
a computer keyboard. Up to 12 calibration points may be entered. Frequency and factor data-entry fields are 
automatically activated for the number of calibration points selected. The user can then enter the appropriate 
data for each point.

K-Factor Backup
Each time a calibration factor is entered or changed, the software prompts the user to copy the previous 
settings to backup memory (Figure 4.24). In the event that an error is made while entering configuration 
parameters, the user can restore the last saved set of configuration settings to the instrument.

Figure 4.24—Prompt to copy previous calibration settings to backup

Select “yes” to save the previous calibration factor to memory. The date and time of this backup is displayed 
next to the “Retrieve K-Factor Backup” button on the K-Factor Entry screen. Only the last saved backup can 
be retrieved.

To retrieve the last saved K-Factor backup, perform the following steps:

 Press the “Retrieve K-Factor Backup” button. A confirmation screen will appear with a prompt to proceed 
or terminate the retrieval. 

 Press “yes” to retrieve the last backup.

 Click “OK” or “Apply” to save the retrieved settings to the configuration file. Because the retrieval of 
these settings represents a change to the current K-Factor settings, you will again be prompted to copy the 
previous settings to backup.

1.

2.

3.
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Gas Volume Correction (Supercompressibility Calculation)
Gas turbine meters are calibrated in actual cubic feet (ACF), and measure gas in actual cubic feet. In some 
applications, a user may benefit from referencing gas measurements back to standard conditions by measuring 
in terms of standard cubic feet (SCF). The MC-III EXP makes this process quick and easy, by using fixed 
average values for the flowing gas temperature and flowing gas pressure. 

By default, this option is disabled.

To access this feature, check the “Enable volume correction” checkbox in the Gas Correction section of the 
K-Factor screen. The “STANDARD” annunciator on the LCD will illuminate, and all other Gas Volume 
Correction data fields will be activated (Figure 4.25).

Figure 4.25—Gas volume correction settings on K-Factor Entry screen

Atmospheric pressure is set at 14.73 psia by default, but can be adjusted to local conditions.

To compensate the gas measurement to standard conditions, complete the following steps: 

 Enter the atmospheric pressure.

 Enter the base pressure and unit. The base pressure is the pressure to which the gas will be compensated 
(typically, 14.73 psia). 

 Enter the base temperature and unit. The base temperature is the temperature to which the gas will be 
compensated (typically, 60°F).

 Enter the working pressure and unit. The working pressure is the user-entered pressure that represents the 
average working (flowing) pressure.

 Enter the working temperature and unit. The working temperature is the user-entered temperature that 
represents the average working (flowing) temperature.

1.

2.

3.

4.

5.
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 Enter a known compressibility factor, or press “Calculate compressibility from gas comp.” to view a 
selection of gas compositions (Figure 4.26). 

To automatically calculate the compressibility factor, enter the gas composition and click on 
“Calculate.”  The software will calculate flowing gas compressibility in accordance with the 
AGA-8 detail method.
The K-Factor Entry screen will reappear, and the calculated super-compressibility factor will be 
displayed.

Figure 4.26—Gas Composition screen  

6.

•

•
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4-20 mA Output

Caution:  Before performing any 4-20 mA calibration, ensure that all peripheral equipment con-
nected to the 4-20 mA current loop is either disconnected or disabled.  Calibrating and 
testing the 4-20 mA output feature on the MC-III EXP with the peripheral equipment in 
operation may cause false alarms or erroneous operation of the peripheral device or as-
sociated equipment.

The 4-20 mA Output screen (Figure 4.27) allows users to configure the MC-III EXP to provide a 4-20 mA 
output representing flow rate. Zero and full-scale values can be configured to represent any flow rate range 
within the range of the flowmeter. A test mode function is also included, allowing a user to calibrate and/or 
verify the output received by an end device.

Figure 4.27—4-20 mA Output screen

The low (or zero) setting is the flow rate value that will produce a 4-mA output. The high (or full-scale) 
setting is the flow rate value that will produce a 20-mA output. Typically, the high value is greater than the 
low value; this scenario is defined as “direct mode” in Figure 4.28, page 61.

Alternatively, users may configure the 4-mA and 20-mA outputs to have an inverse relationship, such that the 
high value is less than the low value. This scenario is defined as “indirect mode” in Figure 4.28, page 61.
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Figure 4.28—Two options for configuring a 4-20 mA output

Flow rates in-between the minimum and maximum rate setpoints will result in an output of current between  
4 mA and 20 mA according to the following calculation:

[ ] [ ]MAX MIN
OUT CURR MIN

I I
I RATE Low I

High Low
−

= × − +
−

Where:

IOUT = output current 

IMAX = maximum current output (20 mA)

IMIN = minimum current output (4 mA)

High = programmed flow rate that produces a 20-mA output

Low = programmed flow rate that produces a 4-mA output

RATECURR= flow rate
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Enabling 4-20 mA Output 
By default, the 4-20 mA output option is disabled. To enable this feature, perform the following steps:

 Check the “Enable” checkbox.

 Click on the pencil icon next to the Low Flow Rate field to launch a data-entry window (Figure 4.29) and 
enter the “low” or “zero” flow rate value that will produce a 4-mA output. Adjust the decimal position, 
if necessary, using the slide bar. A flow rate less than or equal to this minimum setpoint will result in an 
output of 4 mA.

 Click on the pencil icon next to the High Flow Rate field and enter the “high” or “full-scale” flow rate 
value that will produce a 20-mA output. Adjust the decimal position, if necessary, using the slide bar. A 
flow rate equal to or greater than this maximum setpoint will result in an output of 20 mA.

Figure 4.29—Data-entry screen for 4-20 mA low and high values

4-20 mA Output Testing
The MC-III software allows users to test the 4-20 mA output by entering an output current value and reading 
the live value generated in response. 

To use the test mode, press the “Test 4-20 mA Output” button at the bottom of the 4-20 mA Output screen. 
The test page will appear (Figure 4.30, page 63), and the 4-20 mA Output option will be temporarily disabled.

To test the output, enter a value in the Output Current (mA) field, and press “Set Output.” 

1.

2.

3.
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Figure 4.30—4-20 mA output test screen

Pulse Output
The Pulse Output screen (Figure 4.31) allows users to configure the MC-III EXP to provide a pulse output 
representing increments in volume. A test mode function is also included, allowing a user to calibrate and/or 
verify the output received by an end device.

Figure 4.31—Pulse Output screen
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Configuring Pulse Output
By default, the pulse output option is disabled to reduce current consumption. To conserve power, do not 
enable this feature unless it will be used.

To enable the pulse output option, perform the following steps:

 Check the “Enable” checkbox. 

 Enter the pulse duration value using the “plus” and “minus” buttons on the screen, or the page-up and 
page-down keys on a computer keyboard. The pulse length (pulse width) determines the length of each 
output pulse in milliseconds (ms).

 Click on the pencil icon next to the scale field to open a data-entry window (Figure 4.32), and enter the 
scale factor. Adjust the decimal position, if necessary, using the slide bar. The scale factor sets the volume 
increment that will cause a pulse output to occur. The unit for this factor is determined by the unit set for 
the volume display. 

Figure 4.32—Data-entry screen for pulse output scale factor

Note—The scale factor can be any number; it is not limited to powers of 10 (1, 10, 100, etc.).

In applications where high flow rates may occur for extended periods, pulses can be lost due to the 
instrument’s inability to register the flow rate at the maximum output frequency. To avoid the loss of pulses, 
users can raise the scale factor or shorten the pulse duration. The software calculates the maximum flow 
rate that can be reached before pulse caching is likely to occur, and displays the information on the Pulse 
Output screen. In applications where short bursts of high flow rates are common (separators, tank loading, 
dump cycles, etc.), the displayed flow rate can exceed the maximum flow rate for short periods without 
compromising the accuracy of the total represented by the pulse output. 

1.

2.

3.
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Pulse Output Testing
The MC-III software allows users to test the pulse output by writing a value to the pulse accumulator. Such 
tests can aid in troubleshooting problems with hardware compatibility, threshold settings, and pulse duration 
settings.

To use the test mode, press the “Test Pulse Output” button at the bottom of the Pulse Output screen. The test 
page will appear (Figure 4.33), and the Pulse Output option will be temporarily disabled.

To test the output, enter a value in the Pulse Count field, and press “Set Output.” The value in the Live Value 
field will decrement to zero in accordance with the programmed pulse duration.

Figure 4.33—Pulse output test screen 
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Saving and Uploading Configuration Files
The MC-III EXP allows a user to save configuration settings in a file that is stored on the user’s computer and 
can be uploaded to the MC-III EXP as needed. Configuration files are easily identified by the .mc3 extension. 
The default filename begins with “config” and uses the following structure:

File Format Filename Structure
.mc3 “config”<date (YYMMDD)> <time (hhmmss)>.mc3

Example: config050209133922.mc3 is a configuration file that was 
downloaded on February 9, 2005 at 1:39:22 p.m.

Saving a Configuration File
To save current configuration settings for future reference, perform the following steps:

 Select File>Save Configuration File (Figure 4.34). A “Save MC3 Configuration File” screen will appear, 
prompting the user to save the file to the computer hard drive. The default directory is C:\NuFlo log data\
MC-III\<WELL NAME>, however the user can specify a new location, if desired.

Figure 4.34—File dropdown menu allows user to save a configuration file 

 Click “Save.”  An “Information” window will appear to confirm that the file has been saved.

The “wellname” folder will bear the well name that appears on the Wellsite Information screen. If no well 
name is entered on this screen, the folder will be named “NO_WELLNAME” (Figure 4.35, page 67).

 

1.

2.
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Figure 4.35—Default directory for configuration files

Uploading a Configuration File
To upload a configuration file, perform the following steps:

 From the Main screen, select File>Return to Welcome Screen (Figure 4.36). 

 Click on the LCD to connect to the MC-III EXP.

 Click “Upload a configuration” (Figure 4.37, page 68) and click “Do It Now.” A “Load MC3 Configura-
tion File” window will appear (Figure 4.38, page 68), displaying the contents of the MC-III folder. 

 Click on the appropriate well name folder, select the configuration file of your choice, and click “Open.” 
A “Progress” window will appear momentarily, followed by an “Information” window confirming the 
upload.

Figure 4.36—File dropdown menu allows user to return to the Welcome screen

1.

2.

3.

4.
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Figure 4.37—Upload a Configuration option

Figure 4.38—Default directory for configuration files
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Advanced Access 
System configurators and host programmers can also access the software through the Advanced Access menu 
(Figure 4.39). This option provides access to the Modbus® registers for the MC-III EXP. A series of tabs on 
the right side of the screen (real time, input configuration, output configuration...) allows the user to view a 
specific group of registers, or to view all registers in one list. 

Important: The Advanced Access option is not required for the routine operation of the MC-III EXP, 
and novice users should not access this portion of the software unless instructed to do 
so by Cameron technical support personnel.   

Data retrieved from the MC-III EXP while in Advanced access mode can be logged to a file by enabling the 
“Automatically log data polls” checkbox on the Advanced Options screen. The file will include values that are 
retrieved from the instrument when the user clicks the “Get All Data” button or enables “Auto Polling” on the 
Advanced Access screen. See also Automatic Data Logging, page B-6. 

Figure 4.39—Advanced Access screen
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Section 5—Flow Logs and Event Logs
The MC-III™ EXP’s flow archive expands the user’s ability to track flow volume over time by allowing the 
user to view flow data in tabular and trend formats, to save or print log data in reports, and to export log data 
into a spreadsheet. Additionally, an event archive allows users to identify changes to configuration parameters 
and other settings for troubleshooting operational issues.

A user can download logs from the Flow Archive and Event Archive screens as needed, or configure the 
software to automatically download the logs upon connection with the instrument. See Automating Functions 
on Software Startup, page 37, for more information.

When the “download all logs” or “download only new logs” option is selected from the Device Autorun 
Options menu and the “Always do...” checkbox is checked, the software will download both flow logs and 
event logs each time the software connects to the MC-III EXP (Figure 5.1).

Figure 5.1—Device Autorun Options screen allows automated log downloads with every connection

Auto-Save Log Formats
The MC-III EXP automatically saves daily flow logs on the contract hour, and saves hourly flow logs around 
the clock. The instrument also automatically saves an event log each time a user change is made. After 
downloading these logs from the instrument, the software saves the data in a file. By default, the logs are 
saved as .csv files. 

The file format of the auto-save flow log and event log files is user-configurable. To save logs in Excel (.xls) 
format, click Options>Program Options in the task bar, select Downloading from the dropdown options list, 
and check the “XLS-MS Excel File” checkbox (Figure 5.2, page 72).
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Figure 5.2—Log download options

Log Directory and Filenames
Auto-save log files are saved in C:\NuFlo log data\MC-III\<WELL NAME>. The “wellname” folder will bear 
the well name that appears on the Wellsite Information screen. If no well name is entered on this screen, the 
folder will be named “NO_WELLNAME.”

Log filenames incorporate the serial number of the MC-III EXP, the date, the time, and a capital letter 
indicating the log type, as shown below.

File Format Filename Structure
.xls or .csv <Serial number>_<date (YYYYMMDD)>_<time (hhmmss)>_<log 

type indicator> where the log type indicator is  
“H” for hourly, “D” for daily, or “E” for event

Example: 16_20050302_102031_H.xls is an hourly log file from the 
MC-III EXP serial number 16 that was downloaded on March 2, 2005 
at 10:20:31 AM.

Flow Archive
The MC-III EXP automatically saves daily flow logs on the contract hour, and hourly flow logs. The Flow 
Archive screen (Figure 5.3, page 73) allows users to download, view, and print trend charts, and export daily 
and hourly logs. On the Flow Archive screen, users can view up to 384 daily logs and 768 hourly logs in 
tabular format (note the Daily Logs and Hourly Logs tabs at the bottom of the screen), or in a trend chart (see 
Daily Trend and Hourly Trend tabs).
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Figure 5.3—Flow Archive screen

Downloading Flow Logs
To download flow logs, click the “Download” button on the Flow Archive screen, and select either Download 
All Flow Logs or Download Only New Flow Logs (Figure 5.4, page 74). (Download Only New Flow Logs 
will display only flow logs that have been created since the last download was performed.) Tabular views of 
the archive record (Figure 5.5, page 74) include a time stamp showing the exact time each log was recorded, 
as well as flow volume, run time, and supply voltage. Trend views (Figure 5.6, page 75) show the flow 
volume and time stamp only.
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Figure 5.4—Menu for downloading flow logs from the Flow Archive screen

Figure 5.5—Downloaded flow logs (tabular view)
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Viewing Trend Charts
In the daily and hourly trend views, flow volumes are charted on a grid, with flow record numbers forming 
the horizontal axis, and flow volumes shown on the vertical axis. A graphical line defined by two yellow 
endpoints represents the range of archived logs available for viewing. A yellow triangle marks the first record, 
and a yellow circle marks the final record. The arrowhead cursor is paired with dotted circle. As the user drags 
the cursor across the chart, the circle’s position corresponds with the record displayed at the top of the screen 
(Figure 5.6). The circle’s snap function allows the user to pinpoint transitional points within the trend display; 
the greater the zoom, the more precise the navigation.  

Note—The interactive cursor cannot be turned off.  

To zoom in, left-click and drag the mouse to the right and down. 
To zoom out, drag the mouse up and to the left.
To reposition the chart within the viewing window, right-click the chart and move the mouse slowly in 
any direction.
To exit the page and return to the Main screen, press OK.

Figure 5.6—Flow Archive screen, trend view 

Printing/Saving a Report
A flow log can be printed and/or saved as a table (Figure 5.7, page 76) or a trend chart (Figure 5.8, page 76).

To print a log, select the appropriate tab at the bottom of the Flow Archive screen, and press the “Print” 
button in the upper right corner of the Flow Archive screen. (If the display is tabular, the button will read 

•
•
•

•
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“Print Table”; if the display is a chart, the button will read “Print Chart.”) A Print Preview screen will appear, 
displaying the image to be printed.

To print the report, select File>Print from the task bar (Figure 5.7).

Figure 5.7—Print preview, tabular view

Figure 5.8—Print preview, trend view
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To save the report, perform the following steps:

 Select File>Save from the task bar (Figure 5.8, page 76). A “Save Report As” window will open (Figure 
5.9).

 Enter a filename. The filename extension will be .rps.

 Click “Save.” By default, log archive reports are saved in C:\NuFlo log data\MC-III\<WELL NAME>, 
however the user can specify a new location, if desired. The “wellname” folder will bear the well name 
that appears on the Wellsite Information screen. If no well name is entered on this screen, the folder will 
be named “NO_WELLNAME.”

Figure 5.9—Save Report As screen

Viewing a Saved Report
To view a saved report, perform the following steps:

 From the Flow Archive screen, click “Print Table” (or “Print Chart” for trend chart views) in the upper 
right corner of the screen.

 Select File>Load from the task bar at the top of the page (Figure 5.10, page 78). A Load Report window 
will open (Figure 5.11, page 78).

 Click on the report you wish to view. A preview of the report will appear in the right portion of the win-
dow.

 Click “Open.”

1.

2.

3.

1.

2.

3.

4.
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Figure 5.10—Menu for loading a saved report

Figure 5.11—Load Report screen for viewing saved flow log reports
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Exporting Flow Logs 
Flow logs can be directly exported to an .xls or .csv file for ease in viewing and distributing. To export a file, 
perform the following steps:

 Click the “Export Data” button near the top of the Flow Archive screen and select the .xls or .csv format 
(Figure 5.12). 

 When the “Export Daily (or Hourly) Log Data...” window appears, click “Save.” By default, exported 
logs are saved in C:\NuFlo log data\MC-III\<WELL NAME>, however the user can specify a new loca-
tion, if desired (Figure 5.13, page 80). The “wellname” folder will bear the well name that appears on the 
Wellsite Information screen. If no well name is entered on this screen, the folder will be named “NO_
WELLNAME.”

Important Users can also specify the file format to be used for all auto-save logs (.csv or .xls). To 
change the auto-save format, follow the procedure described in Downloading Options, 
page B-5.

Figure 5.12—Dropdown menu for exporting log data

1.

2.
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Figure 5.13—Default directory for exported log files

Event Archive
The Event Archive screen (Figure 5.14) allows users to download, view, export, and print up to 345 user event 
logs. Event logs are generated to track user changes such as K-Factor changes, input setting changes, power-
on and “watch-dog” resets, and the flow and frequency cut-off settings.

Figure 5.14—Event Archive screen 
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Downloading Event Logs
To download event logs, click the “Download” button on the Flow Archive screen, and select either 
Download All Event Logs or Download Only New Event Logs, (Figure 5.15). Download Only New Event 
Logs will display only flow logs that have been created since the last download was performed. Tabular 
views of the archive record (Figure 5.16, page 82) include a time stamp showing the exact time each log was 
recorded, as well as the name of the register changed, and the old and new values assigned to that register.

Figure 5.15—Menu for downloading event logs from Event Archive screen
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Figure 5.16—Downloaded event logs

Printing/Saving a Report
To print an event log, press the “Print Table” button in the upper right corner of the Event Archive screen. A 
Print Preview screen will appear, displaying the image to be printed.

To print the report, select File>Print from the task bar.

To save the report, perform the following steps:

 Select File>Save from the task bar. A “Save Report As” window will open.

 Enter a filename. The filename extension will be .rps.

 Click “Save.” By default, log archive reports are saved in C:\NuFlo log data\MC-III\<WELL NAME>, 
however the user can specify a new location, if desired.The “wellname” folder will bear the well name 
that appears on the Wellsite Information screen. If no well name is entered on this screen, the folder will 
be named “NO_WELLNAME.”

The procedure for printing and saving an event log report is nearly identical to the procedure for printing and 
saving a flow log report. See the flow log screen captures, pages 75 through 77, for reference. 

Exporting Event Logs 
Event logs can be directly exported to an .xls or .csv file for ease in viewing and distributing. To export a file, 
perform the following steps:

 Click the “Export Data” button near the top of the Event Archive screen and select the .xls or .csv format 
(Figure 5.17, page 83). 

1.

2.

3.

1.
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 When the “Export Event Logs...” window appears, click “Save.” By default, exported logs are saved in 
C:\NuFlo log data\MC-III\<WELL NAME>, however the user can specify a new location, if desired. The 
“wellname” folder will bear the well name that appears on the Wellsite Information screen. If no well 
name is entered on this screen, the folder will be named “NO_WELLNAME.” 

Important Users can also specify the file format to be used for all auto-save logs (.csv or .xls). To 
change the auto-save format, follow the procedure described in Downloading Options, 
page B-5.

Figure 5.17—Dropdown menu for exporting log data

2.
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Section 6 - MC-III EXP Maintenance
The MC-III™ EXP is designed to provide many years of service with minimal maintenance. Batteries require 
periodic replacement, and battery life depends on whether battery power is the primary or secondary power 
source. 

All configuration settings are stored in nonvolatile memory; therefore, configuration settings will not be lost 
in the event of battery failure.  

The circuit assembly or keypad may also require replacement over the life of the instrument. Procedures are 
provided in this section. 

Lithium Battery Replacement
The MC-III EXP uses a lithium battery with a life expectancy of approximately 2 years. Due to the flat 
discharge characteristics of the lithium battery, it is difficult to determine how much life remains in a battery 
at any given time. To preserve configuration and accumulated volume data, replace the battery at 2-year 
intervals.

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.   

Warning:  The lithium battery that powers the MC-III EXP is a sealed unit; however, should a lithium 
battery develop a leak, toxic fumes could escape upon opening the enclosure. Ensure 
that the instrument is in a well-ventilated area before opening the enclosure to avoid 
breathing fumes trapped inside the enclosure. Exercise caution in handling and  
disposing of spent or damaged batteries. See additional information on lithium batteries  
in Appendix C of this manual.

Important: Press the ENTER/SAVE key on the keypad before replacing the lithium battery to save 
the accumulated total to nonvolatile memory. Once the battery is replaced and power is 
restored to the unit, the last saved accumulated total will be displayed in the LCD. 

The lithium battery is secured inside the enclosure by a velcro strap and connected to a connector (J1) near the 
top of the circuit assembly. 

To replace a lithium battery in the MC-III EXP, perform the following steps: 

 Unscrew the cover of the enclosure counter-clockwise until it separates from the main body of the enclo-
sure. 

 Using a small standard blade screwdriver, remove the two #4-40 × 7/8” screws located to the right and 
left side of the display (Figure 6.1, page 86).

1.

2.
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Remove screws
to access battery
compartment

Figure 6.1— Removal of faceplate/keypad assembly

 Lift the display/keypad assembly from the enclosure, making sure the circuit assembly does not contact 
the enclosure.  

 Loosen the velcro strap, disconnect the battery from the J1 connector on the circuit assembly, and remove 
the battery from the enclosure (Figure 6.2).

Figure 6.2— Removal/replacement of lithium battery

3.

4.
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 Install the new battery in the enclosure in the same position as the original battery, and secure the Velcro 
tightly around the battery.

 Connect the replacement battery to the J1 connector. 

 Place the circuit assembly over the standoffs and fasten with the two #4-40 × 7/8” screws, ensuring that 
all connector wiring is inside the enclosure.

 Replace the enclosure cover, threading it onto the enclosure in a clockwise direction.

Important: The interruption of power to the MC-III EXP will cause the internal clock time to be inac-
curate. Reset the time via the interactive software. See Time/Date Synchronization, page 
50.

Alkaline Battery Replacement
The alkaline battery pack will require periodic replacement. The dimming of the LCD may be an indicator 
that battery power is diminishing, and the battery pack should be replaced.

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.   

Important: Press the ENTER/SAVE key on the keypad before replacing the alkaline battery to save 
the accumulated total to nonvolatile memory. Once the battery is replaced and power is 
restored to the unit, the last saved accumulated total will be displayed in the LCD. 

The shrink-wrapped alkaline battery pack is secured inside the MC-III EXP enclosure by a Velcro strap and 
connected to a connector (J1) near the top of the circuit assembly. 

To replace the battery pack, perform the following steps:

Unscrew the cover of the enclosure counter-clockwise until it separates from the main body of the enclo-
sure. 

 Using a small standard blade screwdriver, remove the two #4-40 × 7/8” screws located to the right and 
left side of the display (Figure 6.3, page 88).

5.

6.

7.

8.

1.

2.
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Remove screws
to access battery
compartment

Figure 6.3—Removal of faceplate/keypad assembly

Lift the display/keypad assembly from the enclosure.

Loosen the Velcro strap, disconnect it from the J1 connector on the circuit assembly, and remove the bat-
tery from the enclosure (Figure 6.4).  

Figure 6.4—Removal/replacement of alkaline battery pack

3.

4.
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 Install the new shrink-wrapped battery pack in the same position as the original battery pack as shown in 
Figure 6.4, page 88, and secure the Velcro strap to hold the pack tightly in place.

 Connect the replacement battery pack to the J1 connector. 

 Place the circuit assembly over the standoffs and fasten with the two #4-40 × 7/8” screws, ensuring that 
all connector wiring is inside the enclosure.

 Replace the enclosure cover, threading it onto the enclosure in a clockwise direction.

Important: The interruption of power to the MC-III EXP will cause the internal clock time to be inac-
curate. Reset the time via the interactive software. See Time/Date Synchronization, page 
50.

Circuit Assembly Replacement

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.  

Important: Static electricity can damage a circuit board. Handle new boards only by their edges, 
and use proper anti-static techniques (such as wearing anti-static wrist strap or touching 
metal to establish an earth ground) prior to handling a board.

Important: If possible, record the accumulated total and all configuration settings before replacing 
the circuit board. This information can be recorded by hand or captured by saving a con-
figuration file that can be reloaded into the unit after the circuit board is replaced. (See 
Saving and Uploading Configuration Files, page 66.)

To replace the circuit assembly, perform the following steps:

Unscrew the cover of the enclosure counter-clockwise until it separates from the main body of the enclo-
sure. 

Using a small standard blade screwdriver, remove the two #4-40 × 7/8” screws located to the right and 
left side of the display.  

Lift the display/keypad assembly from the enclosure.  

Record the locations of all cable connections to the circuit assembly.  

Using a small standard blade screwdriver, remove all wiring from terminal blocks TB1, TB2, and TB3, 
and J2, ensuring that all wiring that is connected to powered circuits is insulated with tape.

Unplug the battery cable from connector J1 on the circuit assembly.  

Remove the two #4-40 × 5/16” screws fastening the circuit assembly to the keypad assembly (Figure 6.5, 
page 90). 

5.

6.

7.

8.

1.
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3.

4.

5.

6.
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Figure 6.5—Disassembly of circuit board/keypad assembly

Disconnect the keypad ribbon cable from the J3 connector on the LCD side of the circuit assembly as fol-
lows:

Grasp the black clip between a thumb and forefinger (see white arrows in Figure 6.6 below).

Squeeze both sides of the clip and gently pull to release the clip from the plastic connector that holds 
it in place. DO NOT PULL on the ribbon cable. When the black plastic clip is properly disengaged, 
the cable will release freely.

Figure 6.6—To release the ribbon cable from the connector, press in on the side tabs of the connector (white 
arrows) and gently pull forward (black arrow).

8.

a.

b.
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Remove the original circuit assembly from the enclosure.  

Connect the ribbon cable of the keypad to the J3 connector on the LCD side of the circuit assembly as 
follows:

Insert the end of the ribbon cable into the plastic clip.

While holding the ribbon cable in place, press the black plastic clip into the connector until it snaps.

Mount the circuit assembly to the keypad with the two #4-40 × 5/16” screws.  

Reconnect the battery cable to J1 on the circuit assembly.  

Reconnect all wiring to terminal blocks TB1, TB2 and TB3 (and J2, if applicable).  

Mount the display/keypad assembly to the enclosure with the two #4-40 × 7/8” screws.  

Recalibrate the MC-III EXP, then replace the enclosure cover.  

Re-establish power to the peripheral circuitry.

Keypad Replacement

Warning:  To prevent ignition of hazardous atmospheres, do not remove the cover while circuits are 
alive. Under normal conditions, the MC-III EXP poses no hazard when opened in a safe 
area.    

To replace the keypad of the MC-III EXP, perform the following steps:

Unscrew the cover of the enclosure counter-clockwise until it separates from the main body of the enclo-
sure. 

Using a small standard blade screwdriver, remove the two #4-40 × 7/8” screws located to the right and 
left side of the display.

Lift the display/keypad assembly from the enclosure.

Remove the two #4-40 × 5/16” screws fastening the circuit assembly to the keypad (Figure 6.5, page 90).

Disconnect the keypad ribbon cable from the J3 connector on the LCD side of the circuit assembly as fol-
lows:

Grasp the black clip between a thumb and forefinger (see white arrows in Figure 6.6, page 90).

Squeeze both sides of the clip and gently pull to release the clip from the plastic connector that holds 
it in place. DO NOT PULL on the ribbon cable. When the black plastic clip is properly disengaged, 
the cable will release freely.

Remove the circuit assembly.

Connect the ribbon cable of the keypad to the J3 connector on the LCD side of the circuit assembly as 
follows:

Insert the end of the ribbon cable into the plastic clip.

While holding the ribbon cable in place, press the black plastic clip into the connector until it snaps.

 Mount the circuit assembly to the keypad with the two #4-40 × 5/16” screws.

9.

10.
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Mount the display/keypad assembly to the enclosure with the two #4-40 × 7/8” screws.

Recalibrate the MC-III EXP if necessary and replace the enclosure cover.

Firmware Update
Before installing new firmware or moving the instrument to a new site, it is recommended that the user 
clear the EEPROM, which will erase all configuration settings and log data. To clear the EEPROM, choose 
Options/Program Options from the menu bar, select Advanced from the dropdown options list, and click on 
the “Clear EEPROM” button (Figure 6.7).

Technical assistance is typically required for upgrading firmware. Contact Cameron’s Measurement Systems 
Division to arrange an upgrade. 

Warning:   Clicking the “Clear EEPROM” button will delete all configuration settings and log records 
in the MC-III EXP memory.

Figure 6.7—EEPROM clearing and automatic data log option 

 

9.

10.
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Spare Parts List
Quantity Part Number Description

1 9A-30166003 Assembly, Switchplate 
1 9A-50160002 Circuit Assembly
1 9A-90017002 Cable Assembly, Flowmeter 
1 9A-100005111 Battery - Lithium, 3.6 V
1 9A-50099002 Battery Pack, Alkaline (3 “C”), Shrink-wrapped
1 9A-100002605 Desiccant Packet
1 9A-50074001 Assembly, Installation Software CD and CD 

Pocket Folder, MC-III
1 9A-50165003 Manual, User
1 9A-50165004 Manual, Quick-Start 
1 9A-100017622 Union, 1-in.
1 9A-50053010 Control Drawing, Intrinsically Safe RS-485 

Connection, MC-III EXP

Optional Parts List
Quantity Part Number Description

1 9A-30054001 Assembly, Reset Switch, Explosion-Proof, 
with Extension, Fits ¾ in. Female Pipe Thread 
(CSA), for Standard Enclosure

1 9A-50053008 Assembly, Reset Switch, Explosion-Proof, for 
Alternate Enclosure (Red Rim on Cover)

1 9A-50053009 IS Barrier, RS-485
1 9A-90017004 Cable Assembly, 3/4 in. NPT Explosion-Proof 

Union, 2-Pin Connector, 10 in., for External RS-
485 Communications (CSA)

1 9A-101283116 Converter, RS-485 to RS-232, 9-Pin, with 10-ft 
Cable

1 9A-100025195 Converter, RS-485 to RS-232, 25-Pin
1 9A-0112-9015T Converter, RS-485 to RS-232, Serial Port 

Powered, DB9 Connector on Both Ends
1 9A-30028004 Kit, Pole Mount, Plated Steel
1 9A-30028005 Kit, Pole Mount, Stainless Steel

CAUTION: EXPLOSION HAZARD—SUBSTITUTION OF COMPONENTS MAY IMPAIR SUITABILITY   
FOR CLASS I, DIVISION 1. USE OF SPARE PARTS OTHER THAN THOSE IDENTIFIED BY 
CAMERON VOIDS CSA CERTIFICATION. CAMERON BEARS NO LEGAL RESPONSIBILITY 
FOR THE PERFORMANCE OF A PRODUCT THAT HAS BEEN SERVICED OR REPAIRED 
WITH PARTS THAT ARE NOT AUTHORIZED BY CAMERON.
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Appendix A—MC-III EXP Hardware Options

Explosion-Proof Reset/Control Switch
An external explosion-proof reset/control switch (Figure A.1) allows the user to zero the total and view 
daily logs instantaneously without removing the instrument cover or connecting the instrument to a laptop 
computer.

Figure A.1—Explosion-proof reset/control switch

The reset/control switch assembly mounts in either threaded conduit opening in the instrument housing. 

The assembly is available in two models for use with the standard enclosure shown above, and the alternate 
enclosure shown in Figure 2.3, page 12. The alternate enclosure is identifed by the red ring around the face of 
the cover. Both parts are included in the Spare Parts list on page 93.

Installation
If the switch is ordered with a Scanner 2000 microEFM, it will be installed prior to shipment.

To add a switch to an existing MC-III, connect the leads to connector J2 on the main circuit board (Figure 
A.2, page A-2).
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Figure A.2—Explosion-proof switch wiring

Operation
Zeroing the Total. To reset the total with an explosion-proof switch, press and hold the switch for 3 seconds, 
then release it.

Important:  When resetting the total with the explosion-proof reset switch, do not release the switch 
prematurely. Releasing the switch too quickly (before 3 seconds have passed) will  
activate the daily log view function and WILL NOT reset the volume to zero.

Viewing Daily Logs. To view daily logs with the explosion-proof switch, press the switch for 1 second and 
release it. The words “Daily Volume Archive” will scroll across the bottom of the LCD and the day index 
(Figure A.3) will display “01.” The daily flow total recorded at the last contract hour will appear at the top of 
the LCD. 
 
The index number represents the number of days previous to the current date. For example, totals from two 
days previous are read by pressing the switch until “02” appears in the Day index field of the display.

Subsequent press-and-release actions increment the daily index, allowing the user to select a specific daily 
total.
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Figure A.3—Daily index (Day) displays
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Additionally, when the log viewing function times out, the accumulated total is automatically saved to 
memory.

Saving the Total. When the daily log display times out, the MC-III EXP will automatically save the 
accumulated total.

Explosion-Proof Communications Adapter
The explosion-proof communications adapter provides an RS-485 connection for connecting a laptop or PC to 
the instrument without removing the instrument cover. When the adapter is ordered with an MC-III EXP, it is 
factory installed. The installed adapter is comprised of an RS-485 adapter socket, a blanking plug, and a union 
nut (Figure A.4). It may be relocated to either conduit opening in the instrument housing. 

An RS-232 to RS-485 converter cable (available from Cameron’s Measurement Systems Division) is required 
for connecting the adapter to a laptop computer. See Spare Parts, page 93, for converter cable options.

    

Adapter socket

Union nut

Blanking plug

 
Figure A.4—Components of explosion-proof communications adapter

Assembly of the Plug Connector
A plug connector that mates with the RS-485 adapter socket is shipped with the device (uninstalled). This 
plug connector should be wired to an RS-485 converter cable as shown in Figure A.5, page A-4, and stored 
with the cable when the COM adapter is not in use.
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PLUG CONNECTOR
(LEFT AND RIGHT WIRE POSITIONS ARE VALID ONLY
WHEN PLUG IS FACING SOCKET IN POSITION SHOWN)

COM ADAPTER SOCKET

RS-485
CONVERTER

RS-232 9-PIN 
CONNECTOR

TD(A)

TD(B)

GND

Part No. 101283116

GND

+12V

Figure A.5—Wiring of plug connector to Cameron 9-pin RS-232 to RS-485 converter cable

Connecting to the Communications Adapter
Take the following precautions when disassembling the communications adapter.

!
 WARNING: When a hazardous area is present, ensure the union nut and blanking plug are 

properly fitted in the conduit opening. The explosion-proof rating applies only when the union 
nut and blanking plug are secured in place. When the union is broken, the device is no longer 
explosion-proof.

!
 WARNING: Before disassembling the union nut and blanking plug, make sure the area is non-

hazardous. 

To connect a PC or laptop to the communications adapter, perform the following steps:

  Unscrew the union nut to expose the connector socket shown in Figure A.4, page A-3. (A blanking plug 
will be removed with the union nut. Store the union nut and blanking plug in a safe place. They will need 
to be reinstalled when the adapter is not in use.)

 Wire the plug connector to an RS-485 converter cable, if it is not already attached (Figure A.5).

 Insert the plug connector into the adapter socket.

 Connect the converter cable to the PC or laptop.

1.

2.

3.

4.
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Disconnecting the Communications Adapter 
To disconnect the adapter, perform the following steps:

 Remove the plug connector (with converter cable attached) from the socket.

 Place the blanking plug inside the union nut (removed in step 1).

 Screw the union nut onto the union half to cover the socket. Hand-tighten to ensure a snug connection.

Note: Do not disconnect the plug connector from the RS-232 to RS-485 converter cable when it is not in 
use. For best results, store the plug connector with the converter cable. 

Installation of Adapter (when purchased separately from an MC-III EXP)

!
 WARNING: If the communications adapter is ordered separately from the MC-III EXP Flow Ana-

lyzer, the conduit openings in the enclosure will be sealed with brass or stainless steel plugs. 
Do not remove the plug from the enclosure to install the adapter unless the area is known to be 
non-hazardous.

To install a communications adapter purchased separately from an MC-III EXP, perform the following steps:

 Thread the cable of the adapter through a conduit opening in the instrument housing and screw the adapter 
into place.

 Connect the adapter cable to the RS-485 port on the MC-III EXP main circuit board (Figure A.6). 

 Connect the plug connector to an RS-485 converter cable (Figure A.5, page A-4), if applicable.
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Figure A.6—Circuit board connection for communications adapter
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Appendix B—Software Program Options
In addition to the standard configuration and flow log menus, the MC-III™ interface software includes a 
Program Options menu that allows users to customize the way the software functions, handles log data, and 
communicates.

To access the Program Options menu, select Options in the menu bar; Program Options is the last entry in the 
dropdown list (Figure B.1).

Figure B.1—Program Options menu location

General Options
The General Options screen allows a user to change the threshold setting used to generate a user prompt for 
synchronizing the internal clock with the time displayed on the user’s computer. 

The MC-III EXP includes a real-time clock for timekeeping and log time stamps, and the internal time and 
date is preset at the factory. However, if the factory-set time and date are inaccurate for the user (for example, 
if the user is in a different time zone), the program will automatically detect the difference between the 
device’s internal time and the date and the time/date displayed on the user’s personal computer and prompt 
the user to authorize time and date synchronization. 

By default, the MC-III prompts a user to synchronize the clock display if the time difference is 60 seconds or 
more. To change the time difference required to generate a “synchronize” prompt, enter a new threshold value 
(seconds) in the General Options screen (Figure B.2, page B-2) and click “OK.”
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Figure B.2—Threshold setting for internal clock synchronization

Autorun Options
When the software connects with the MC-III EXP, the Device Autorun Options screen appears, prompting the 
user to select any of six actions, including navigating to one of three configuration screens, downloading flow 
and event logs, and uploading a configuration file. A checkbox at the bottom of the screen allows the user to 
automate the selected function each time the software connects to the instrument. 

The Autorun Options screen in the Program Options menu allows a user to terminate all autorun functions, or 
change the autorun selection. 

To change an autorun setting —that is, to initiate an autorun action, to terminate an autorun action, or to 
change to a different autorun action at the next connection—select Autorun from the Program Options menu 
(Figure B.3, page B-3), select the appropriate checkboxes, and click “OK.” Verify that the “Always do...”  
checkbox is checked if the selected function is to be automated upon each software connection.
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Figure B.3—Menu for changing autorun option selection

Communications Options
The Communications Options screen (Figure B.4) allows users to customize communication parameters for 
optimizing performance, depending on the communication path. 

Figure B.4—Menu for changing communication parameters
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Express Connect Option
By default, the MC-III interface software automatically attempts to connect to the instrument when a user 
clicks on the desktop application icon. This feature is controlled by the “Always attempt Express Connect on 
program startup” checkbox setting in the Communications Option screen (Figure B.4, page B-3).

When multiple devices are daisy-chained together in a network, the “express connect” function can interfere 
with the user’s ability to connect to a specific device. To disable the Express Connect function, deselect the 
“Always attempt...” checkbox and click “OK.” The software will now attempt to connect with the instrument 
only when the user clicks on the LCD image on the Welcome screen or selects File>Express Connect. For 
more information, see Software Connection in Multi-Device Network, page 39. 

To cancel the “express connect” function without disabling the autorun option, the user can toggle between 
connect/disconnect by clicking in the LCD area of the device on the Welcome screen.

Auto-Negotiate Option
When connected devices are capable of switching baud rates automatically or when devices are directly 
connected to an MC-III EXP, a user may configure the MC-III interface to automatically negotiate the fastest 
baud rate during device connection. This “negotiated” baud rate does not replace the configured baud rate, 
but rather provides a temporary boost of baud rate while the computer is connected to the device for faster 
downloads. After the software disconnects, the device reverts to the configured baud rate. 

By default, this function is disabled. To enable automatic baud rate negotiation on device connect, check the 
“Attempt auto-negotiation….” check box in the Communications Option screen (Figure B.4, page B-3) and 
click “OK”.  To initiate an immediate search for the fastest baud rate without exiting to the Welcome screen, 
check the “Enable auto-negotiated baud rate” checkbox, click the “Test Now” button to the right of the 
checkbox, and click “Yes” at the prompt in the Confirm dialog box.  

Enable Auto-Negotiated Baud Rate Option
The “Enable auto-negotiated…” checkbox enables usage of the baud rate that has been automatically selected 
or “negotiated” by the MC-III interface, either upon connection with the instrument or when the “Test Now” 
button was last clicked. See also Auto-Negotiate Option above.

Request-to-Send (RTS) Line Option
Some RS-485 to RS-232 converter modules require a request-to-send (RTS) line for switching between a 
“receive” and “transmit” state. This checkbox allows the software to toggle this line, ensuring that incoming 
data will be readily transmitted and that the converter will not stall in a “receive” mode after a period of 
inactivity. By default, this option is enabled. To disable the option, deselect the checkbox and click “OK.”

Enable Modbus Address Support for Firmware Versions 1.06 through 1.08
Operators with MC-III units programmed with firmware versions 1.06 through 1.08 must check the checkbox 
labeled “Enable Modbus Address Support for Firmware Versions 1.06 through 1.08” to ensure seamless 
Modbus communication with their units. Operators using any other firmware version with the MC-III should 
leave the checkbox unchecked. 

Timing Parameters
Presend Delay
On the Communications Options screen, a user can enter a presend delay (milliseconds) to help ensure a 
successful connection between the computer and the MC-III EXP when the instrument is networked with a 
radio or other low-speed device. The computer transmits a request to send, which turns the device on, and then 
waits the specified length of time before attempting to transmit data. By default, this parameter is set to zero.
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Number of Retries
By default, the computer will make two attempts to connect to the MC-III EXP before providing an error 
message. In situations where timeouts are anticipated—for example, due to a slow-speed computer—the 
user can increase the length of time allowed for a connection by inputting a larger number in the Number of 
Retries field.

Timeout Period Type
A user can select an “optimal” timeout, which is based on the response time of the MC-III EXP to various 
requests for data at all baud rates during extensive testing, or a fixed timeout determined by the user. By 
default, the “optimal” period type is enabled. When a communication error occurs, the “optimal” timeout 
allows the software to respond much faster than the more conservative fixed timeout. The optimal setting 
is recommended when the software is connecting directly to the instrument. The fixed timeout type is 
recommended when data is being transmitted through a radio or other network device (serial to TCP/IP) and 
there are recognizable delays in the communication system.

Timeout Period
When a fixed timeout period type is selected, the user enters the timeout period value (in milliseconds) in the 
Timeout Period field. When an “optimal” timeout period type is selected, the user can use this field to enter 
a percentage by which the “optimal” timeout period is extended. This extension can be advantageous when 
connecting to a slow computer.

Downloading Options
The MC-III EXP automatically saves daily flow logs on the contract hour, and hourly flow logs around the 
clock. The instrument also automatically saves an event log each time a user change is made. By default, the 
logs are saved as .csv files. The Downloading Options screen (Figure B.5) allows a user to change the format 
of the auto-save flow logs and event logs to Excel (.xls) files.

Figure B.5—Menu for changing the auto-save log file format 
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To save the logs in .xls format, check the “XLS-MS Excel File” checkbox (Figure B.5, page B-5). Additional 
checkboxes allow for changes in the appearance of downloaded log data.

Users can also export flow data to a .csv or .xls file as needed. For complete information, see Exporting Flow 
Logs, page 79.

Advanced Options
Clear EEPROM
The Clear EEPROM function will erase all configuration settings and log data.  This task is typically 
performed when updating to a new firmware version or before moving the instrument to a new site.  To clear 
the memory, click on the “Clear EEPROM” button (Figure B.6).  

Technical assistance is typically required for upgrading firmware.  Contact Cameron’s Measurement Systems 
Division to arrange an upgrade. 

Warning:   Clicking the “Clear EEPROM” button will delete all configuration settings and log records 
in the MC-III EXP memory.

Figure B.6—Menu for clearing EEPROMs and enabling automatic data logs

Automatic Data Logging
Data retrieved from the MC-III EXP while in Advanced access mode can be logged to a file by enabling 
the “Automatically log data polls” checkbox on the Advanced Options screen. To specify the filename and 
location of the file, click the folder icon on the right of the Data logging filename field. The file will include 
values that are retrieved from the instrument when the user clicks the “Get All Data” button or enables “Auto 
Polling” on the Advanced Access screen. See also Advanced Access, page 69. 
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Appendix C—Lithium Battery Information

Lithium Battery Disposal 
Once a lithium battery is removed from a device and/or is destined for disposal, it is classified as solid waste 
under EPA guidelines. Depleted lithium batteries are also considered to be hazardous waste because they meet 
the definition of Reactivity, as per 40 CFR 261.23(a)(2), (3) and (5). This document describes how the lithium 
reacts violently with water, forms potentially explosive mixtures with water, and when exposed to certain pH 
conditions, generates toxic cyanide or sulfide gases.

Federal law requires that depleted lithium batteries be sent to a fully permitted Treatment, Storage and 
Disposal Facility (TSDF) or to a permitted recycling/reclamation facility. 

Important:  Do not ship lithium batteries to Cameron. Cameron facilities are not permitted recycling/
reclamation facilities.

Caution:   Profiling and waste characterization procedures must be followed prior to shipping a 
lithium battery to a disposal site. It is the shipper’s responsibility to comply with all ap-
plicable federal transportation regulations (see below).

Transportation Information

Warning:   The MC-III EXP™ Flow Analyzer contains lithium batteries. The internal component (thio-
nyl chloride) is hazardous under the criteria of the Federal OHSA Hazard Communication 
Standard 29 CFR 1920.1200. Before shipping a lithium battery or equipment containing a 
lithium battery, verify that the packaging and labeling conforms with the latest version of 
all applicable regulations.

The transport of the lithium batteries is regulated by the United Nations, “Model Regulations on Transport of 
Dangerous Goods,” (special provisions 188, 230, and 310), latest revision.

Within the US the lithium batteries and cells are subject to shipping requirements under Part 49 of the Code 
of Federal Regulations (49 CFR, Parts 171, 172, 173, and 175) of the US Hazardous Materials Regulations 
(HMR), latest revision.

Shipping of lithium batteries in aircraft is regulated by the International Civil Aviation Organization (ICAO) 
and the International Air Transport Association (IATA) requirements in Special Provisions A45, A88 and A99, 
latest revision.

Shipping of lithium batteries on sea is regulated the International Maritime Dangerous Goods (IMDG) 
requirements in special provisions 188, 230 and 310, latest revision.

Shipping of lithium batteries on road and rail is regulated by requirements in special provisions 188, 230 and 
310, latest revision.

Material Safety Data Sheet
For a link to the current MSDS for the lithium batteries used to power the MC-III EXP Flow Analyzer, see the 
Cameron website: www.c-a-m.com.
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Appendix D—Communications Protocol

Firmware Version 2.00 
Register Table Version 1

Introduction
The communications protocol for the MC-III is in accordance with Modicon, Inc. RTU Mode Modbus® as 
described in Modicon Modbus Protocol Reference Guide, PI-MBUS-300 Rev. J, June 1996. All registers are 
implemented as 4X or holding registers. Reading of registers is implemented via function code 03H (Read 
Holding Registers). Writing to registers is implemented via function code 10H (Preset Multiple Registers). 
The instrument provides Enron Modbus® compliant downloads for hourly, daily and event records. For details 
on Enron Modbus®, refer to Specifications and Requirements for an Electronic Flow Measurement Remote 
Terminal Unit for Enron Corp., Dec. 5, 1994.

Supported Commands
The Modbus® functions supported by the MC-III are as follows: 

Function Code
(Hex)

Description

03 Read Holding Registers
05 Preset Boolean  

(for Enron event record acknowledgement)
10 Preset Multiple Registers

For the read holding and preset multiple registers, the instrument supports the full 250 bytes of data in a 
message. This corresponds to 125 registers in 16-bit holding register size and 62 registers in 32-bit holding 
register size. 

Data Types
Various data types are implemented in the MC-III. The following table lists the formats and the numbers of 
bytes and registers associated with each type.

Data Type Byte Count Register Count
Floating Point (FP) 4 2
Floating Point (FP32) 4 1
Unsigned Word (U16) 2 1
Packed ASCII (PA) 2 1

The Floating Point (FP) type follows the IEEE-754 format and consists of 32 bits contained in two registers. 
It is utilized for parameters and values that are not integers. For example, Instantaneous Flow Rate is a 
parameter that is a floating-point data type. It can be interpreted by reading two registers, starting with register 
17014.
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The Floating Point-32 bit (FP32) data type follows the IEEE-754 format and consists of 32 bits contained in 
a single register. The word ordering for multiple register data types, such as floating-point numbers or long 
integers, is for the most significant word to appear first in the message. 

The Unsigned Word (U16) type is used for 16-bit integers and fits into one register. 

The Packed ASCII (PA) type contains two bytes that are two unsigned characters. Generally, multiple Packed 
ASCII types are arranged consecutively for implementing strings. For example, the device’s well name is a 
string of 10 unsigned characters that is implemented as 5 Packed ASCII registers. Here is an example of a 
well name that contains the string, “Test Well 413.” 

Register Hexadecimal # ASCII Characters
210 54 65 Te
211 73 74 St
212 20 57 <SPACE>W
213 65 6C el
214 6C 20 l<SPACE>
215 34 31 41
216 33 FF 3<UNUSED>

 
Unused characters at the end of each string will report 0xFF hexadecimal.

Registers 
Each register has an Access type: read-only or read-write, as described below. 

Access Type Description
Read Only (RO) Register can only be read. 

Read/Write (R/W) Register can be read and written. 

The registers are grouped into Modbus® map blocks based on function. The MC-III contains the following 
map functions.

Function Starting Register
System Configuration 1000
Real Time 1200
Input Configuration 2000
Output Configuration 4000
Holding Register (16-bit) 8000 and 17001
Holding Register (32-bit) 7000
Control Registers 70
Wellsite Parameters 200
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Note All registers cited in this document refer to the address of the register that appears in the actual Mod-
bus® message. For example, register 17001 has an address of 0x4268 Hexadecimal in the message. 

Note Two sets of 16-bit holding registers are provided (starting at 17001 and 8000). The “8000” set should 
be used with master devices that require the holding registers to be in the range of 40000 to 49999.

System Configuration
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

1000 03E8 Product Code U16 RO 64

1001 03E9 Register Table Version Number U16 RO 1

1002 03E
Firmware Version Number 
(Version = register value divided by 100) 
(Example:  100 = Version 1.00)

U16 RO

1003 03EB Manufacture Date (MMYY) U16 RO
1004 03EC Sales Date (MMYY) U16 RO
1005 03ED Serial Number 1 U16 RO
1006 03EE Serial Number 2 U16 RO

1007 03EF
Power Mode

0 = High Power
1 = Low Power

U16 R/W 1

1008 03F0
Internal System Sample Rate
Number of seconds to measure temperature 
and battery voltage

U16 R/W 3600

1009 03F1 Slave Address 
[1-65535, not including 252-255 or 64764] U16 R/W 1

1010 03F2

Baud Rate
Low Power            High Power

0 - 300                  5 - 9600
1 - 600                  6 - 19200
2 - 1200                7 - 38400
3 - 2400                8 - 57600
4 - 4800              10 - 115200
5 - 9600

U16 R/W 5

1011 03F3 Bus Delay – mS of delay before transmitting data 
(Delay = register value multiplied by 10 mS) U16 R/W 1

(10 ms)

1012 03F4
Bus Timeout – mS of delay before resetting 
Modbus® 
(Timeout = register value multiplied by 10 mS)

U16 R/W 5
(50 mS)

1013 03F5 Contract Hour 
[0-23] U16 R/W 8

1014 03F6 Lock Code 
[0001-9999] U16  R/W 0
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System Configuration
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

1015 03F7
Lock Code Enable

0 - Disabled
1 - Enabled

U16 R/W 0

1016 03F8 LCD Contrast 
[0-31] U16 R/W 6

Product Code (register 1000)
The Product Code is a read-only parameter used for identification. This parameter is set at the factory and it 
will always read 0x40 hexadecimal (64 decimal).

Firmware/Register Table Version Numbers (registers 1001, 1002)
The Firmware Version and Register Table Version numbers are unsigned 16-bit integers. These parameters are 
set at the factory and are read-only. To determine the firmware version number, read the appropriate register 
and divide the value read by 100. The general format for firmware version numbers is A.BC. For example, the 
firmware register number is read as 0xA7 hexadecimal. This represents 167 and a firmware version of 1.67. 

Manufacture Date/Sales Date (registers 1003, 1004)
These parameters are set at the factory and are read-only. These registers are formatted as MMYY. For 
example, a value of 0905 represents the date September 2005.

Slave Address (register 1009)
The Modbus® slave address is an unsigned word (U16) data type that has a range of values from 1 to 65535, 
not including 252 through 255 or 64764. The slave address is configured from a laptop or via the keypad and 
is stored in nonvolatile memory.

Important All MC-III devices will respond to addresses 252 through 255 and 64764, and the  
response will always be at a baud rate of 9600 baud. For this reason, addresses 252 
through 255 and 64764 are reserved and should never be used. 

When the slave address is written, the response message will be at the current address. After the response 
message is transmitted, the MC-III will change to the new slave address.

Baud Rate (register 1010)
The baud rate is an unsigned word (U16) data type that sets the data rate on the serial port. When the baud rate 
is written, the response message will be at the current baud rate. After the response message is transmitted, the 
MC-III will change to the new baud rate.
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Real Time
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access

1200 04B0 Year 
(Real Year = register value plus 2000) U16 R/W

1201 04B1 Month [1-12] U16 R/W
1202 04B2 Day [1-31] U16 R/W
1203 04B3 Hour [0-23] U16 R/W
1204 04B4 Minute [0-59] U16 R/W
1205 04B5 Second [0-59] U16 R/W

This block of registers is used to set the instrument’s internal clock. To set the time, it is recommended that all 
registers be written in one message. 

The time and date can also be read in the holding register groups as floating-point data.

Input Configuration
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

2000 07D0

Volume Units

Units 
0 = No Units
1 = Gallons
2 = Barrels
3 = Cubic Meters
4 = Cubic Feet
5 = Liters

Units × 1000
16 = No Units
17 = Gallons
18 = Barrels
19 = Cubic Meters
20 = Cubic Feet
21 = Liters U16 R/W 2

Standard Units
32 = No Units
33 = Gallons
34 = Barrels
35 = Cubic Meters
36 = Cubic Feet
37 = Liters

Std. Units × 1000
48 = No Units
49 = Gallons
50 = Barrels
51 = Cubic Meters
52 = Cubic Feet
53 = Liters

2001 07D1

Volume Decimal Point Location
1 = Tenths
2 = Hundredths
3 = Thousandths
4 = Ten Thousandths

U16 R/W 1
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Input Configuration
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

2002 07D2

Rate Volume Units

Units 
0 = No Units
1 = Gallons
2 = Barrels
3 = Cubic Meters
4 = Cubic Feet
5 = Liters

Units × 1000
16 = No Units
17 = Gallons
18 = Barrels
19 = Cubic Meters
20 = Cubic Feet
21 = Liters U16 R/W 2

Standard Units
32 = No Units
33 = Gallons
34 = Barrels
35 = Cubic Meters
36 = Cubic Feet
37 = Liters

Std. Units × 1000
48 = No Units
49 = Gallons
50 = Barrels
51 = Cubic Meters
52 = Cubic Feet
53 = Liters

2003 07D3

Rate Time Base
0 = Second
1 = Minute
2 = Hour
3 = Day

U16 R/W 3

2004 07D4

Rate Decimal Point Location
0 = No digits to the right of the decimal point
1 = Tenths
2 = Hundredths
3 = Thousandths

U16 R/W 2

2005 07D5 Calculation Period 
(sec) U16 R/W 4

2006 07D6

Turbine Meter Input Configuration
0 = Pulse Input
1 = TFM - LOW
2 = TFM - MED
3 = TFM - HIGH

U16 R/W 1

2007 07D7 Low Frequency Cut-Off Threshold 
(Hz) U16  2

2008 07D8

Factor Type
1 = 1-Point K-Factor
2 = 2-Point K-Factor
…
12 = 12-Point K-Factor

U16 R/W 1
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Input Configuration
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

2009 07D9

Factor Units
0 = No Units
1 = Gallons
2 = Liters
3 = Barrels
4 = Cubic Feet
5 = Cubic Meters

U16 R/W 1

2010 07DA

Factor Decimal Point Location
0 = No digits to the right of the decimal point
1 = Tenths
2 = Hundredths
3 = Thousandths
4 = Ten Thousandths

U16 R/W 2

2011 07DB Calibration Frequency [1] (Hz)* FP R/W 1.00
2013 07DD Calibration Frequency [2] (Hz)* FP R/W 1.00
2015 07DF Calibration Frequency [3] (Hz)* FP R/W 1.00
2017 07E1 Calibration Frequency [4] (Hz)* FP R/W 1.00
2019 07E3 Calibration Frequency [5] (Hz)* FP R/W 1.00
2021 07E5 Calibration Frequency [6] (Hz)* FP R/W 1.00
2023 07E7 Calibration Frequency [7] (Hz)* FP R/W 1.00
2025 07E9 Calibration Frequency [8] (Hz)* FP R/W 1.00
2027 07EB Calibration Frequency [9] (Hz)* FP R/W 1.00
2029 07ED Calibration Frequency [10] (Hz)* FP R/W 1.00
2031 07EF Calibration Frequency [11] (Hz)* FP R/W 1.00
2033 07F1 Calibration Frequency [12] (Hz)* FP R/W 1.00

2035 07F3 Calibration Factor [1]*
(pulses per configured factor unit) FP R/W 900.00

2037 07F5 Calibration Factor [2]*
(pulses per configured factor unit) FP R/W 1.00

2039 07F7 Calibration Factor [3]*
(pulses per configured factor unit) FP R/W 1.00

2041 07F9 Calibration Factor [4]*
(pulses per configured factor unit) FP R/W 1.00

2043 07FB Calibration Factor [5]*
(pulses per configured factor unit) FP R/W 1.00

2045 07FD Calibration Factor [6]*
(pulses per configured factor unit) FP R/W 1.00

2047 07FF Calibration Factor [7]*
(pulses per configured factor unit) FP R/W 1.00

2049 0801 Calibration Factor [8]*
(pulses per configured factor unit) FP R/W 1.00
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Input Configuration
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

2051 0803 Calibration Factor [9]*
(pulses per configured factor unit) FP R/W 1.00

2053 0805 Calibration Factor [10]*
(pulses per configured factor unit) FP R/W 1.00

2055 0807 Calibration Factor [11]*
(pulses per configured factor unit) FP R/W 1.00

2057 0809 Calibration Factor [12]*
(pulses per configured factor unit) FP R/W 1.00

2059 080B Standard Measurement Correction Factor 
(to be configured by software only) FP RO 1.00

2061 080D Low Flow Rate Cut-Off Threshold 
(in terms of configured flow rate units) FP R/W 1.00

*Calibration frequencies and calibration factors are associated in pairs—i.e., Calibration Frequency [1] and 
Calibration Factor [1]— and must be sorted in ascending order, based on calibration frequency values, prior 
to writing the values to the instrument. Therefore, Calibration Frequency [1] should be the smallest of all 
calibration frequencies.

Output Configuration
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access Default

4000 0FA0
Pulse Output Source
0 = Test Mode/Disabled
1 = Enabled

U16 R/W 0

4001 0FA1 Pulse Output Duration  
(time is register value multiplied by 10 ms) U16 R/W 10

(100 mS)
4002 0FA2 Pulse Output Decimal Point Location U16 R/W 2

4003 0FA3 Pulse Output Scale Factor
(in terms of configured volume units) FP R/W 1.00

4005 0FA5
Analog Output Source
0 = Test Mode/Disabled
1 = Enabled

U16 R/W 0

4006 0FA6 Analog Output Decimal Point Location U16 R/W 2

4007 0FA7 Analog Output Low Value
(in terms of configured flow rate units) FP R/W 0.00

4009 0FA9 Analog Output High Value
(in terms of configured flow rate units) FP R/W 1700.00

Important Two sets of 16-bit holding registers are provided (starting at 17001 and 8000). The  
“8000” set displayed in parentheses in the Holding Registers table on page C-9 should 
be used with master devices that require the holding registers to be in the range of 40000 
to 49999.
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Holding Registers (16-bit Mode)
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access

17001
(8000)

4269
(1F40)

Hourly Pointer 
[1 to 768] FP RO

17003
(8002)

426B
(1F42)

Daily Pointer 
[1 to 384] FP RO

17005
(8004)

426D
(1F44)

Event Counter 
[1 to 345] FP RO

17007
(8006)

426F
(1F46)

Real Date 
(MM/DD/YY) FP RO

17009
(8008)

4271
(1F48)

Real Time 
(HH:MM:SS) FP RO

17011
(8010)

4273
(1F4A)

Grand Total
(in terms of configured volume units) FP RO

17013
(8012)

4275
(1F4C)

Instantaneous Flow Rate
(in terms of configured flow rate units) FP RO

17015
(8014)

4277
(1F4E)

Daily Total
(in terms of configured volume units) FP RO

17017
(8016)

4279
(1F50)

Daily Run Time
(seconds) FP RO

17019
(8018)

427B
(1F52)

Hourly Total
(in terms of configured volume units) FP RO

17021
(8020)

427D
(1F54)

Hourly Run Time
(seconds) FP RO

17023
(8022)

427F
(1F56)

Polling Total
(in terms of configured volume units) FP RO

17025
(8024)

4281
(1F58)

Polling Run Time
(seconds) FP RO

17027
(8026)

4283
(1F5A)

Previous Day Total
(in terms of configured volume units) FP RO

17029
(8028)

4285
(1F5C)

Previous Day Run Time
(seconds) FP RO

17031
(8030)

4287
(1F5E)

Previous Hour Total
(in terms of configured volume units) FP RO

17033
(8032)

4289
(1F60)

Previous Hour Run Time
(seconds) FP RO

17035
(8034)

428B
(1F62)

Previous Polling Total
(in terms of configured volume units) FP RO

17037
(8036)

428D
(1F64)

Previous Polling Run Time
(seconds) FP RO

17039
(8038)

428F
(1F66)

Polling Index
[0-65535] FP RO

17041
(8040)

4291
(1F68)

Internal Temperature 
(°C) FP RO
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Holding Registers (16-bit Mode)
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access

17043
(8042)

4293
(1F6A)

Supply Voltage 
(VDC) FP RO

17045
(8044)

4295
(1F6C)

Battery Voltage 
(VDC) FP RO

17047
(8046)

4297
(1F6E)

Grand Total 
(base unit) FP RO

17049
(8048)

4299
(1F70)

Instantaneous Flow Rate 
(base unit) FP RO

17051
(8050)

429B
(1F72)

Daily Total 
(base unit) FP RO

17053
(8052)

429D
(1F74)

Daily Run Time 
(seconds) FP RO

17055
(8054)

429F
(1F76)

Hourly Total 
(base unit) FP RO

17057
(8056)

42A1
(1F78)

Hourly Run Time 
(seconds) FP RO

17059 
(8058)

42A3
(1F7A)

Polling Total 
(base unit) FP RO

17061
(8060)

42A5
(1F7C)

Polling Run Time 
(seconds) FP RO

17063
(8062)

42A7
(1F7E)

Previous Day 
(base unit) FP RO

17065
(8064)

42A9
(1F80)

Previous Day Run Time
(seconds) FP RO

17067
(8066)

42AB
(1F82)

Previous Hour 
(base unit) FP RO

17069
(8068)

42AD
(1F84)

Previous Hour Run Time
(seconds) FP RO

17071
(8070)

42AF
(1F86)

Previous Polling Total
(base unit) FP RO

17073
(8072)

42B1
(1F88)

Previous Polling Run Time
(seconds) FP RO

17075
(8074)

42B3
(1F8A)

Polling Index 
[0-65535] FP RO

17077
(8076)

42B5
(1F8C) Pulse Output Pulses FP R/W

17079
(8078)

42B7
(1F8E) Analog Output Current FP R/W

17081
(8080)

42B9
(1F90)

Calculated K-Factor
(in terms of configured factor unit) FP RO
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Base Units/Configured Units
The holding register area provides two blocks of registers. The first block is based on the configured units 
of measurement. The configured volume units will follow the settings in the Volume Unit register (2000). 
The configured rate units will follow the settings in the Rate Volume units (2002) and the Time-Base register 
(2003).

For example, if the settings for the volume unit is 2 (BBL), all of the total parameters such as Grand Total 
(17011), Daily Total (17015), etc. will be in terms of barrels. The values in these registers will change if the 
user changes the units of measurement that appear on the LCD. 

The second block is in terms of base units. These register values are independent of the configured volume 
units in the Volume Unit, Rate Volume Unit, and Time-Base registers. For base units, the time base is always 
measured in seconds, and the volume and rate volume units are measured in gallons. If the standard correction 
factor has been enabled, the volume unit is standard gallons. The standard gallon is calculated as the gallon 
measurement times the Standard Measurement Correction factor (2059). If the x1000 unit is enabled, the 
volume unit is gallons times 1000. 

Conversion Factors
For base units, the volume unit and rate volume unit is measured in gallons.To convert gallons to another unit 
of measure, use the conversion factors listed in the table below. For example, to convert gallons to barrels, 
multiply gallons times 0.02380952381. 

To Convert From Gallons To... Multiply By...
No units 1.00000000000
Barrels 0.02380952381
Cubic meters 0.00378541178
Cubic feet 0.13368055556
Liters 3.78541178400

Polling Registers
The MC-III EXP device stores the volume accumulated since the last polling sequence in a set of polling 
registers (17023). In addition, the instrument monitors the number of seconds of flow time in each polling 
interval (17025). There is also an index to the number of polls requested (17039). 

The polling sequence is started by writing to the Control Register. Writing the Control Register 1 (70) with 
a value of 20000 decimal transfers the polling total (17023) and polling run time (17025), to the previous 
polling total (17035) and previous polling run time (17037) registers, increments the polling index (17039) 
register and resets the polling total and polling run time registers.

Pointer/Daily/Event Pointer (registers 17001 through 17006)
These registers provide an index of the last record that was stored in the log data. These values start at 1 and 
increment with each newly created log. When the maximum number of records is reached, the pointer resets 
at 1 and starts incrementing again.

Real Date (registers 17007, 17008)
This register is a floating-point representation of the date, formatted as MMDDYY. For example, a value of 
91005 represents a date of September 10, 2005. 
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Real Time (registers 17009, 17010)
This register is a floating-point representation of time, formatted as HH:MM:SS. For example, a value of 
180205 represents a time of 6:02:05 PM. 

Totals 
The instrument provides Grand Total (17011), Daily Total (17015), Hourly Total (17019) and a Polling Total 
(17023). It also provides Previous Day Total (17027), Previous Hour Total (17031), and Previous Polling 
Total (17035). These totals are available in terms of configured units and base units. Refer to Base Units/
Configured Units, page D-11, for details. 

Pulse Output Pulses (register 17077)
When the pulse output is enabled (see Pulse Output Source, register 4000), this register indicates the 
current number of output pulses to be sent to the output relay, based on the configured duration. In a typical 
application, this register will generally indicate a small number, then quickly count down to zero. In a 
situation where pulses are being cached, the pulses register will indicate a large value. When the pulse output 
is disabled, a user can use this register to write a desired number of pulses to be output, for use in testing end 
devices. Users can also perform this output test from the software Pulse Output configuration screen. For 
details, see Pulse Output Testing, page 65.

Analog Output Current (register 17079)
When the analog output is enabled (see Analog Output Source, register 4005), this register indicates the 
calculated output current based on the low and high values and the instantaneous flow rate. When the analog 
output is disabled, a user can use this register to write a desired output current for use in testing end devices. 
Users can also perform this output test from the software 4-20 mA Output configuration screen. For details, 
see 4-20 mA Output Testing, page 62.

Calculated K-Factor (register 17081)
This register represents the K-factor that was used for the most recent calculation interval. This number 
is calculated based on the factor type (register 2008), the instantaneous frequency from the flowmeter, 
calibration frequencies (registers 2011 through 2033), and calibration factors (registers 2035 through 2057). 
The unit of measurement for this register is pulses per configured factor unit. Once the K-factor is calculated 
based on frequency and K-factor points, this value is multiplied by 1000 if the user chooses to read the 
volume in units x 1000, and it is divided by the Standard Measurement Correction Factor (register 2059).

Holding Registers (32-bit Mode)
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access

7000 1B58 Hourly Pointer 
[1 to 768] FP32 RO

7001 1B59 Daily Pointer 
[1 to 384] FP32 RO

7002 1B5A Event Counter 
[1 to 345] FP32 RO

7003 1B5B Real Date 
(MM/DD/YY) FP32 RO

7004 1B5C Real Time 
(HH:MM:SS) FP32 RO
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Holding Registers (32-bit Mode)
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access

7005 1B5D Grand Total
(in terms of configured volume units) FP32 RO

7006 1B5E Instantaneous Flow Rate
(in terms of configured flow rate units) FP32 RO

7007 1B5F Daily Total
(in terms of configured volume units) FP32 RO

7008 1B60 Daily Run Time
(seconds) FP32 RO

7009 1B61 Hourly Total
(in terms of configured volume units) FP32 RO

7010 1B62 Hourly Run Time
(seconds) FP32 RO

7011 1B63 Polling Total
(in terms of configured volume units) FP32 RO

7012 1B64 Polling Run Time
(seconds) FP32 RO

7013 1B65 Previous Day Total
(in terms of configured volume units) FP32 RO

7014 1B66 Previous Day Run Time
(seconds) FP32 RO

7015 1B67 Previous Hour Total
(in terms of configured volume units) FP32 RO

7016 1B68 Previous Hour Run Time
(seconds) FP32 RO

7017 1B69 Previous Polling Total
(in terms of configured volume units) FP32 RO

7018 1B6A Previous Polling Run Time
(seconds) FP32 RO

7019 1B6B Polling Index
[0-65535] FP32 RO

7020 1B6C Internal Temp 
(°C) FP32 RO

7021 1B6D Supply Voltage 
(VDC) FP32 RO

7022 1B6E Battery Voltage 
(VDC) FP32 RO

7023 1B6F Grand Total 
(base unit) FP32 RO

7024 1B70 Instantaneous Flow Rate 
(base unit) FP32 RO

7025 1B71 Daily Total 
(base unit) FP32 RO
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Holding Registers (32-bit Mode)
Register  
(Decimal)

Register 
(Hex) Description Data 

Type Access

7026 1B72 Daily Run Time
(seconds) FP32 RO

7027 1B73 Hourly Total 
(base unit) FP32 RO

7028 1B74 Hourly Run Time
(seconds) FP32 RO

7029 1B75 Polling Total 
(base unit) FP32 RO

7030 1B76 Polling Run Time
(seconds) FP32 RO

7031 1B77 Previous Day 
(base unit) FP32 RO

7032 1B78 Previous Day Run Time
(seconds) FP32 RO

7033 1B79 Previous Hour 
(base unit) FP32 RO

7034 1B7A Previous Hour Run Time
(seconds) FP32 RO

7035 1B7B Previous Polling Total 
(base unit) FP32 RO

7036 1B7C Previous Polling Run Time
(seconds) FP32 RO

7037 1B7D Polling Index 
[0-65535] FP32 RO

7038 1B7E Pulse Output Pulses FP32 R/W
7039 1B7F Analog Output Current FP32 R/W

7040 1B80 Calculated K-Factor
(in terms of configured factor unit) FP32 RO

Control Register
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access

70 0046 Control Register #1 U16 R/W
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The Control register allows specific functions to be implemented via the communication port. The following 
table shows the value to be written to the control register to implement the desired function. 

Code Function

20000

Transfers the polling total and polling run time 
to the previous polling total and previous polling 
run time registers, increments the polling index 
register, and resets the polling total and polling run 
time registers.

30000 Resets grand total
40000 Loads factory defaults
40040 Creates processor reset

Wellsite Parameters
Register 
(Decimal)

Register 
(Hex) Description Data 

Type Access

200 00C8 Company Name [20 characters] PA RO
210 00D2 Well Name [20 characters] PA RO
220 00DC Site Location [20 characters] PA RO
300 012C Site ID [20 characters] PA RO
310 0136 Tag Name [10 characters] PA RO
315 013B Legal Description [34 characters] PA RO
400 0190 Sensor Model Number [20 characters] PA RO
410 019A Sensor Serial Number [20 characters] PA RO
420 01A4 Measurement Type [20 characters] PA RO
500 01F4 User Note [64 characters] PA RO

These registers provide access to the ASCII characters that are used in the Wellsite Information screen of the 
software. These registers are read-only; if these parameters need to be changed, the user must use the interface 
software program. 

Log Data
The MC-III provides Enron Modbus® compliant downloads. For detailed instructions on downloading hourly, 
daily and event data, refer to Specifications and Requirements for an Electronic Flow Measurement Remote 
Terminal Unit for Enron Corp. If an Enron host is not available or is too cumbersome to implement, the Enron 
records are individually addressed in another Modbus® map. Contact Cameron technical support for details.

The following registers are used for hourly, daily and event log registers. Hourly and daily records comprise 
five values (registers). See the Hourly/Daily Record Format table, page D-16. Note that event records are 
downloaded one at a time. 
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Enron Registers
Register  
(Decimal)

Register 
(Hex) Description Data Type Access

32 0020 Enron Modbus® Event Log Register
Refer to Enron 
Event Record  

Format
 RO

700 02BC Enron Modbus® Hourly Log
Refer to Enron 

Hourly/Daily 
Record Format

RO

701 02BD Enron Modbus® Daily Log
Refer to Enron 

Hourly/Daily 
Record Format 

RO

7000 1B58 Hourly Pointer
[1 to 768] FP32 RO

7001 1B59 Daily Pointer
[1 to 384] FP32 RO

7002 1B5A Event Counter
[1 to 345] FP32 RO

Enron Hourly/Daily Record Format
Parameter Data Type

Date  
(MMDDYY) FP32

Time  
(HH:MM:SS) FP32

Total  
(base units) FP32

Flow Time 
(number of seconds of flow) FP32

Supply Voltage 
(VDC) FP32

Enron Event Record Format
Parameter Data Type

Status U16
Address U16
Time  
(HH:MM:SS) FP32

Date  
(MMDDYY) FP32

As-Found FP32
As-Left FP32
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The Event Log status is a 16-bit value used to indicate the reset source in the event log. The following table 
indicates the reset status.  

Reset Status
Status Code Value

Normal 0
Power-On Reset 3
Watch-Dog 8
Software Reset 16
Flash Memory Error 32

Log Capacity
Log Type Capacity

Hourly Logs 768
Daily Logs 384
Event Logs 345
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WARRANTY - LIMITATION OF LIABILITY:  Seller warrants only title to the products, soft-
ware, supplies and materials and that, except as to software, the same are free from defects 
in workmanship and materials for a period of one (1) year from the date of delivery.  Seller 
does not warranty that software is free from error or that software will run in an uninterrupted 
fashion.  Seller provides all software “as is”.  THERE ARE NO WARRANTIES, EXPRESS 
OR IMPLIED, OF MERCHANTABILITY, FITNESS OR OTHERWISE WHICH EXTEND 
BEYOND THOSE STATED IN THE IMMEDIATELY PRECEDING SENTENCE.  Seller’s li-
ability and Buyer’s exclusive remedy in any case of action (whether in contract, tort, breach 
of warranty or otherwise) arising out of the sale or use of any products, software, supplies, 
or materials is expressly limited to the replacement of such products, software, supplies, 
or materials on their return to Seller or, at Seller’s option, to the allowance to the customer 
of credit for the cost of such items.  In no event shall Seller be liable for special, incidental, 
indirect, punitive or consequential damages.  Seller does not warrant in any way products, 
software, supplies and materials not manufactured by Seller, and such will be sold only with 
the warranties that are given by the manufacturer thereof.  Seller will pass only through to 
its purchaser of such items the warranty granted to it by the manufacturer.
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